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[bookmark: _Toc314554989]Introduction

Welcome! TamTamCRM is a Customer Relationship Management Application, which will enable you to proficiently manage, populate and update your customer relationship information. TamTamCRM will make your customer relationship activities more efficient, easily managed and organized. With TamTamCRM everyone can record all of their interactions with clients, keeping all co-workers well informed of the current state of issues, sales opportunities and scheduled activities. TamTamCRM offers multiple business information management on new business opportunities, sales leads, product listing, installation units, business contacts, numerous customer accounts and other business activities, such as assigned tasks scheduling, make calls and send meeting invitations. Considering the enormous functionalities, thanks to the user-friendly interface, TamTamCRM is easy to use software. 
By recording all new business activities with TamTamCRM, you can keep track of qualified leads and convert them in specific opportunities. Welcome on TamTamCRM board! We are making our way to a better business. 
[bookmark: _Toc314554990]ABOUT THIS GUIDE
 
The TamTamCRM User Guide is intended for new users who are interested to leverage on the features and functionalities of TamTamCRM to increase productivity. This guide will lead you to the fundamental concepts and help you step-by-step to get comfortable with the application. With this guide, you will be able to perform extensive activities and implement some specific administration features which will be part of the TamTamCRM operation activities.
[bookmark: _SugarCRM_Overview][bookmark: _Toc314554991]TAMTAMCRM OVERVIEW

TamTamCRM is a system that manages information and processes around your relationship with your customers, not only the marketing and sales aspects of that relationship but also the ongoing service and support aspects. TamTamCRM represents one of the best systems available in the market for the manner in which the system is navigated. The TamTamCRM navigation is simple and easy.  Just click the tab placed across the top to access specific function of, such as:
Home
Organizations
Product
Installation Unit
Cases
Activities
Contacts
Opportunities
Leads
Documents
Emails
Campaigns
Projects

You will be able to handle your customer accounts through the business cycle with the modules listed above. The cycle would begin by producing and segmenting leads to scheduling day to day business activities and generating reports. 
Most of the steps in the business cycle are connected, thus TamTamCRM has related sub-panels in each of the module, which would speed up and ease the navigation. When you open some activity, say, an account, you will see sub-tabs below the detail view of the activity. The sub-tabs contain links on various fields, clicking on which will take you to the, the related contact, or the related account, or other related feature. Besides, you can not only view and edit this information but also create new information. 
[bookmark: _Toc314554992]TamTamCRM’s Basic Functions
Below are the basic functions of TamTamCRM:
Creating organizations, branches and contacts, and relating multiple contacts to a single organization and branches.
Creating product and installation units. 
Creating project
Following links between related data.
Creating and tracking the Sales Pipeline from leads to opportunities to contacts and organizations.
Creating and monitoring sales activities and accumulating activity history.
Scheduling activities with colleagues by referring to their calendars.

[bookmark: _Toc314554993]TamTamCRM’s Basic Features
TamTamCRM is provided with a number of useful features which help manage information and processes around your relationship with your customers. Fundamental features include:

Sales-force automation: This includes lead capture and the promotion of leads to Opportunities.
Lead source analysis of sales and opportunities.
Document management and revision control: This helps in managing and retaining reference copies of important corporate documents. 
Opportunity tracking: This tracks the sales stage and percentage likelihood.
Definition of sales teams and territories: This helps in managing information sharing and tracking sales performance by territory. 
Shared calendar management: This can be used for arranging meetings.
Service case tracking: There are also other service/support capabilities such as tracking software bugs, and managing support contract renewals. 
Flexible reporting: This extracts precisely the information you want to see. 
Corporate directory: This can be used for contacting fellow employees. 
Maintaining organization records separate from contact records.
Maintaining organization and contact history.
Integrated web-based email.
Interface consolidation: This includes news feeds, views of financial metrics, integration of external web links and applications. 

[bookmark: _Toc314554994] Efficiently with TamTamCRM  
TamTamCRM’s powerful capabilities, if adopted and utilized right, will change the whole way you do business: 

TamTamCRM’s new marketing communications capabilities will help increase sales. 
Automatic sharing information with everyone instantly, necessity to type in information only once and common awareness of everyone in the business of where to find information help reduce costs.
 Dealing with employees who now know more about what's going on in the customers’ organizations increases the level of customers’ satisfaction. 
Identification of most productive lead sources and conversion of perspective leads into opportunities, as well as better understanding of sales pipelines help manage all processes more efficiently.  

In order to take real advantage of the TamTamCRM, you need to know how to use it from the very initial steps. Full information about how to start working with TamTamCRM is given in the next chapters of this User Guide. 

[bookmark: _Getting_Started_with][bookmark: _Toc314554995]GETTING STARTED WITH TAMTAMCRM 

The main focus of this chapter is how to prepare to work with TamTamCRM. The chapter will answer the question: “What will I need for successful implementation of my tasks with TamTamCRM?”

Topics include:

“Technical Requirements” 
“Accessing TamTamCRM ”
 
[bookmark: _Technical_Requirements][bookmark: _Toc314554996]Technical Requirements

Before you begin using the system, ensure that you have the required software installed and configured on your system as follows:
A current Web browser on your computer. TamTamCRM has been successfully tested on the following browsers:
Google Chrome 6.0 and higher
Mozilla Firefox 2.0 and higher
Microsoft Internet Explorer 7.0 and higher
Safari 4.0 and higher
Microsoft Internet Explorer 5.0 and higher
Konqueror version 3.2 and higher

You may encounter problems if you try to access TamTamCRM using older Web browser versions such as Internet Explorer 4 or Netscape 4.x. If you are unsure about which version you are using, click Help > About or similar options on the menu bar in your browser to display the version number.

Enable Java Script and cookie support on your Web browser. If you encounter problems accessing the system, check your browser configuration to ensure both Java Script support and cookie support are enabled as follows: 
- Internet Explorer: Click Tools > Internet Options > Privacy and Security tabs;
- Firefox: Click Tools > Options > Privacy and Web Features tabs.







[bookmark: _Accessing_Sugar_Suite][bookmark: _Toc314554997]Accessing TamTamCRM 
You can access TamTamCRM through a Web browser. To enter the system, you need to log in. Enter the TamTamCRM URL in the address bar of your Web browser. The Login window displays. Enter your username and password, assigned to you by the system and administrator and click on Login:

[bookmark: _Managing_Your_Password][bookmark: _Sugar_Suite_Modules]
If login successful, your name will be displayed at the top right of the screen. You can click it to view and edit your default settings. You can also view the list of modules you are allowed to access, and your access permissions, such as View, Edit, and Delete, for each module. 

To View and Edit user profile:
Click your name at the top right of the screen. You will redirect to the user profile tab.

The User’s profile tab displays information such as full name, user name, phone number, address, title, and email address.  


To Change the Password
· Click Password tab.
· In the Current Password field, enter your current password.
· In the New Password field, enter your new password.
· In Confirm Password field, enter your new password again.
· Click Save to change the password.


[bookmark: _Toc314554998]TamTamCRM Module Options
The following options are available from any screen in the TamTamCRM application:
· Global Search: This field allows users to enter a letter or a keyword to search all the modules for matching records.
· System Links: This links, located at the top right-hand corner of the page, are common to all modules. These include your name, Logout, Employees, Support, and About. When an administrator logs in, the Admin link is also visible.
· You Name: Click this link, located at the top right of the page, to view your settings. These settings include your profile information, layout options, and so on.
· Employees: Click this link to view a list of other employees in your organization. This list, maintained by the administrator, displays information such as name, title, phone number, department, and email address. Click a name to view detailed information about the employee. Every user is listed as an employee. 
· Admin: This link displays only if you log in as the administrator. Click this link to access the Administration Home page to perform administrative tasks.
· Support: Click this link to view the TamTamCRM Support page, which provides links to TamTamCRM documentation and FAQs to guide you through the process of learning the TamTamCRM application.
· About: Click this link to learn more about TamTamCRM and view version information. 
· Last Viewed: This list displays records that you last accessed within the module, as well as calls and meeting you recently scheduled. 

[bookmark: _Viewing_and_Managing][bookmark: _Toc314554999]Viewing and Managing Record Information

Every module represents a record type such as organizations, opportunities etc. TamTamCRM provides three types of views for every module: a list view, a detail view, and an edit view. Let’s have a look at each of these separately. 


List view: The list view displays links to individual records in table format. The list view also displays other relevant information such organizations, dates etc for each record:

 

Detail view: To drill down to the record’s detail information, just click a record name. You can also click the view icon to navigate to the detail view and the Edit icon to navigate to the edit view, if you have edit permissions. The detail view displays the detail page with all the available information for a record such as name, modified date, and related records. The related records are displayed in the appropriate sub-panels. The detail page provides four options which is edit, delete, and duplicate record information. Similarly, you can edit and delete records in sub-panels. You can also create a new record or select one from the existing list:








Edit view: The edit view allows you to revise the information that you viewed in the detail view.


[bookmark: _Toc314555000]To View and Edit Record Information

Click the record name on the list to view its details. Then click the Edit button on the top of the page if you want to edit the record:



[bookmark: _To_manage_related][bookmark: _Toc314555001]To Manage Related Information in Sub-Panels

The detail page displays also related information in sub-panels. For example, the detail page of an opportunity display sub-panels for related activities, contacts, leads and so on. Each sub-panel consists of rows to list multiple records:



You can add more records to the list by clicking Create above the sub-panel; adjusting the necessary fields and clicking Save above the sub-panel. (If you need to fill in the full information for the record, click the Full Form button):


To edit or remove a record, click the corresponding edit or rem icon respectively:
 


To minimize a sub-panel, click the arrow icon that is located next to its name:
  

That will make all records under this sub-panel invisible.

To move a sub-panel to a different location on the page, place the cursor on the arrow icon, hold down the cursor, drag the panel to the new location and release the cursor.

[bookmark: _Toc314555002]Tracking and Managing Record History

The detail page of every record displays a History sub-panel that enables you to track record-related activities such as meetings, notes, attachments, and archived emails. Each row in the panel displays icons to edit or remove the record. You can also use this sub-panel to create and record new activities.

To track and manage record history

1. To view the details of a listed note, meeting, attachment, or email, click the Subject title.
2. To view a summary of all the listed records in a separate window, click View Summary.
3. To edit or delete a record, click the appropriate edit or rem icon respectively.
4. To archive an email related to the record, click Archive Email. 
[bookmark: _Editing_and_Deleting]
[bookmark: _Managing_Sugar_Dashlets][bookmark: _Toc314555003]Managing TamTamCRM Dashlets

Dashlets are user-configurable panels on the Home page that allow you to specify the items that you want to view on your home page. A dashlet displays a list of item records that is similar to the list view displayed on a module’s home page. TamTamCRM displays a collection of dashlets for items such as meetings, activities, and Organizations on your home page. On the picture below, the dashlets on our TamTamCRM’s home page are outlined with red color. 



You can configure each dashlet to display the rows, columns, and filters that you need. For example, you can change a dashlet’s title or choose to view only your items. You change the number of rows to be displayed and select what rows need to be displayed and what need to be hidden with the help of special arrow buttons on the edit form. 

To edit a dashlet

1. Click on the Edit icon in the top right corner of the dashlet’s panel:


2. Implement the necessary changes to the edit form which will drop down as you click the Edit icon and click Save:



To add a dashlet

1. On the Home module, click Add Dashlets:


2. The available dashlets display on the left:



Click a dashlet name to add it to your home page. Each time you click the name, a new dashlet is added on the page.

To manage dashlets
1. To move a dashlet, place the cursor on its title, press and hold down the mouse button and move it to the new location, and then release the mouse.
2. To delete a dashlet, click the Delete icon. When the system displays a message confirmation, click OK to confirm its removal:



3. To refresh a dashlet, click the Refresh icon:



Note: If you cannot add or move dashlets, check with the administrator to ensure that the functionality has been enabled.
[bookmark: _Merging_Duplicate_Records_1][bookmark: _Toc314555004]Merging Duplicate Records
Use this function to merge duplicate records into single records to update and clean up the data. You can merge records in the following modules: Organizations or Accounts, Contacts, Leads, Opportunities and Cases.


To merge duplicate records from the list view:
1. On the module’s home page, select the duplicate records and click the Merge Duplicates or Find Duplicates tab:

The Merge Records page displays 2 different fields. One is from primary record placed on the left side and another field from the duplicate records placed on the right side. Click the << button to choose required fields from the duplicate data to be replaced with the primary data. Any fields that have different data will be displayed beside the << button.
· To indicate the duplicate records as the primary, click Set as Primary above the duplicate fields. The system will exchange position for both records. 
· To substitute any required field in the primary record with a field from a duplicate record, click the << button. The system will change the data in primary record to the data from the duplicate record.

2. Click Save Merge.

To merge duplicate records from the detail view:

1. The first step of finding duplicates display on the screen. You will have to set filters to specify the field that you want to search for. For example, you can search for records that have the same billing address or phone number.
2. Select one or more filters and click Next Step; to remove a filter, click the Trash icon located next to the field name.
3. The search results display all the records that contain duplicate information for the specified field.
4. To view the details of a record, click its name in the search results.
5. Select the records that you want to merge and click Perform Merge.
6. The Merge Records page displays on the screen.

















Below is the example of the Merge Records page:



3. Click Save Merge to merge record, all related information will be moved to the primary record, and the duplicate records will be deleted.

[bookmark: _Merging_Duplicate_Records][bookmark: _Searching_for_Information][bookmark: _Toc314555005]Searching for Information on TamTamCRM 

You can perform the following types of searches in TamTamCRM:

“Global Search”
“Basic Search”
“Advanced Search”

Below we shall look more closely at each type of search.
[bookmark: _Global_Search][bookmark: _Toc314555006]Global Search
You can perform a global keyword search at the system level for text that matches the beginning of key field names. Our database configuration makes global searches not case-sensitive. To perform a global search, enter the keyword in the Search field and click Search:



If you do like this, the system will search Organizations, Contacts, Leads, Opportunities, Cases, and Projects and display search results for each of these modules. 


The module with the most records displays at the top of the search results page:


[bookmark: _Basic_Search][bookmark: _Toc314555007]Basic Search

You can perform a basic keyword search within most modules. To perform a basic search, in the Search sub-panel on the module’s home page, enter values for one or more fields and click Search. To find only records that are related to your tasks and activities, select the only “My Items” box:



The search fields are context-sensitive and vary depending upon the module you are searching. When you type a character in a field, the system performs a quick search of possible values and presents a list of values starting with that character. Typing additional characters restricts the resulting list.
These rules are also applicable to advanced search. You can edit or delete records in the search results. 
[bookmark: _Advanced_Search][bookmark: _Toc314555008]Advanced Search

To further filter the search results, click the Advanced Search link. The system displays additional fields that vary depending on the module you select:



[bookmark: _Using_SugarCRM_Modules][bookmark: _Using_TamTamCRM_Modules]In this chapter, we have made our initial steps around TamTamCRM navigation and functionality. Read the next chapter of this User Guide to find out exactly how to use TamTamCRM modules. Using TamTamCRM Modules

In the previous section of this User Guide, we have looked at the basic concepts of TamTamCRM functioning.  Now, we can move on to a more detailed view of the TamTamCRM modules, which are the most functional part of TamTamCRM’s interface. 

Topics include:
				
“Home Module”
“Organization Module”
“Products Module”
“Installations Units Module”
“Cases Module”
“Activities Module”   
 “Contacts Module”                                
“Opportunities Module”	               
“Leads Module”		               
 “Documents Module”
 “Emails Module”
“Campaigns Module”
“Projects Module”

[bookmark: _Home_Module][bookmark: _Toc314555009]Home Module

[bookmark: BM1555680][bookmark: BM1275362]When you login into the TamTamCRM, the Home module will be displayed on the screen. The tabs for other modules display alongside the Home module tab. By default, the Home page displays the dashlets listed below. You can remove the ones that you do not need and add other dashlets.

- Discover TamTamCRM - Displays TamTamCRM web site.
- My Top Open Opportunities - Lists the opportunities that you share with other team members;
- My Leads - Lists the leads that you share with other team members;
- My Contacts – Lists contacts that you share with other team members;
- My Organizations – Displays organizations assigned to you by yourself or other users and shared with other team members;
- My Feed - The TamTamCRM Feed dashlet on your Home page enables users to notify each other immediately when one of you creates a new contact, lead, opportunity, or case. Users are also notified when a lead is converted and when a case or opportunity is closed. Additionally, the User Feed enables you to post your status along with external links, images, and YouTube videos;
- TamTamCRM News – Displays TamTamCRM news;
- My Meetings - Displays meeting invitations including the subject of the call, the duration, and the start date;
- My Calls - Lists the calls that you have to make assigned to you by yourself or other users;



[bookmark: _Toc314555010]Managing Chart
[bookmark: BM1556605]Use the Dashlets to view and manage charts based on custom and predefined reports. A chart is a graphical display of report output:


[bookmark: BM1278193]
Customizing Predefined Charts

To enhance performance, the system does not automatically recalculated chart data each time you click the Dashboard tab. To recalculate the data source, click Refreshbutton above the chart.

[bookmark: BM1278195]You cannot delete predefined charts but you can edit them to suit your requirements. 
[bookmark: BM1278196]TamTamCRM provides the following predefined charts:

· [bookmark: BM1465856]All Opportunities by Lead Source. A pie chart of that displays the proportion of total sales opportunities for each lead source.
· [bookmark: BM1278198][bookmark: BM1278199]All Opportunities by Lead Source by Outcome. This bar chart displays total opportunities for each lead source. 
· Outcome by Month. This bar chart displays the total sales pipeline for each month. 
· [bookmark: BM1498952]Campaign ROI. Displays a campaign’s return on investment.
· My Pipeline by Sales Stage. A horizontal stacked bar chat that displays total opportunities for each sales stage. Each bar is made up of multi-colored segments which represent the outcome.
· Pipeline by Sales Stage: This horizontal bar chart displays the total ringgit or dollar amounts for all opportunities grouped by sales stage.
[bookmark: BM1441440]
To customize a predefined chart

[bookmark: BM1278202]1. 	On the Home Module, click the Edit icon on the top right corner of the chart. 
[bookmark: BM1278203]A dialog box displays the details of the report on which the chart is based:





[bookmark: BM1278207][bookmark: BM1441450]2. 	Edit the details as necessary and click Submit. The chart reflects the changes to the report.
[bookmark: BM1278218]
To manage charts

· [bookmark: BM1278219]To ensure that the chart is displaying the latest data, click the Refresh icon at the top right-hand corner of the chart. 
· [bookmark: BM1278220]To change the order in which the charts are displayed, click the down arrow on the Dashboard tab and select Change Layout. Alternatively, select the chart title and drag and drop the chart at the desired location.
· [bookmark: BM1278221]To remove a chart from the dashboard, click the Delete icon at the top right-hand corner of the chart.
· [bookmark: BM1556627]To add a chart back on the dashboard, click Add Dashlet. The Add Dashlet window displays the list of pre-defined charts.
· [bookmark: BM1278224]To copy a chart for inclusion in a document, take a screen copy (such as by using Alt-PrtScn on Windows) and then crop the captured image in an image editor such as Photoshop. 
[bookmark: _Organizations_Module][bookmark: _Toc314555011]Organizations Module
[bookmark: BM1555891]Use this Organizations module to create and manage customer organizations for your organization. Previous name of Organizations Module is Accounts Module. The rename is done because it’s easy for the user to identify the organization. 
  


[bookmark: BM1275852]Every organization contains customer information such as name and address. Each organization can be associated with other records such as opportunities, activities, leads, installation units, products and contacts.
 
[bookmark: BM1275853]The Action bar displays the following options:
Create Organization, View Organizations, Import Organizations, Create Branch and View Branches 
[bookmark: BM1275861][bookmark: _Toc314555012]To Create an Organization
1. [bookmark: BM1555919][bookmark: BM1275871]In the Action bar, click Create Organizations. 
2. On the Organizations page, enter the following information:
· [bookmark: BM1275873]Organization Name. Enter a name for the organization.
· [bookmark: BM1275879]Website. Enter the URL for the organization’s Web site.
· [bookmark: BM1275874]Office Phone. Enter the phone number of the organization.
· [bookmark: BM1275875]Fax. Enter the fax number for the organization.
· [bookmark: BM1449674]Address Information. Enter the primary address and other address information. To copy the other address from the primary address, select the Copy address from left checkbox.
· [bookmark: BM1355676][bookmark: BM1449795]Email Address. Enter an emails address for the organization and your contacts and campaign targets within the organization. If an email address is incorrect, select Invalid to indicate it. 
· To add an additional email address, click Add Address. You can add multiple email addresses.
· [bookmark: BM1355616]Description: Enter a description for the lead. 
· [bookmark: BM1275887]Type. Enter the organization category.
· [bookmark: BM1275888]Annual Revenue. Enter the annual revenue.
· [bookmark: BM1275886]SIC Code. Enter the Standard Industrial Classification code that indicates your organization’s type of business.
· [bookmark: BM1275881]Member of. Enter the names of organization associated with the organization.
· [bookmark: BM1275878]Campaign. Enter a campaign address for the organization.
· [bookmark: BM1275885]Industry. From the drop-down list, select the industrial sector to which the organization belongs.
· [bookmark: BM1275882]Employees. Enter the number of employees in the organization.
· [bookmark: BM1275880]Ticker Symbol. Enter the stock ticker symbol for the organization.
· [bookmark: BM1275883]Ownership. Specify the owner information.
· [bookmark: BM1275884]Rating. Enter the organization’s rating in the industry.	
· [bookmark: BM1449673]Assigned to. Enter the name of the individual who is responsible for communicating with the lead. To choose an existing user, click Select, and choose the person from the User List. By default, this is assigned to you.

See an example of the completed “Create Organization” form below:



3. [bookmark: BM1275894]Click Save to save the new Organization information; click Cancel to exit the page without saving the information.

[bookmark: _Toc314555013]To Create a Branch
In the Action bar, click Create Branches. Optionally, you can use the “Create Organization” quick form.
On the Organizations page, enter the following information:
· Name. Enter a name for the organization.
· Office Phone. Enter the phone number of the organization.
· Website. Enter the URL for the organization’s Web site.
· Industry. From the drop-down list, select the industrial sector to which the organization belongs.
· Employees. Enter the number of employees in the organization.
· Ticker Symbol. Enter the stock ticker symbol for the organization.
· Ownership. Specify the owner information.
· Rating. Enter the organization’s rating in the industry.
· Alternate Phone. Enter alternate phone number of the organization.
· Fax. Enter the fax number for the organization.
· Type. Enter the organization category such as Customer or Partner.
· Annual Revenue. Enter the annual revenue for the organization.
· User. Enter the name of the individual who is responsible for communicating with the lead. To choose an existing user, click Select, and choose the person from the User List. By default, this is assigned to you.
· Organization. Enter the names of organization associated with the organization.
· Address Information. Enter the primary address and other address information. To copy the other address from the primary address, select the Copy address from left checkbox.
· Email Address. Enter an emails address for the organization and your contacts and campaign targets within the organization. If an email address is incorrect, select Invalid to indicate it. If you sent out campaign emails this contact and the individual chose to opt-out of receiving them, select Opted Out.
· To add an additional email address, click Add Address. You can add multiple email addresses.
· Description: Enter a brief description for the lead. 
See an example of the completed “Create Branches” form below:

[bookmark: BM1275896][bookmark: _Toc314555014]To View and Manage Organizations
· [bookmark: BM1275900]To sort the organizations list, click the   icon beside it; to reverse the sort order, click the column title again. 
· [bookmark: BM1275901]To edit or delete all or some organizations on the list, select any organization and click delete from action drop down list.
· [bookmark: BM1275905][bookmark: BM1275906]To view the details of an organization, click its name in the list. The detail page will displays sub-panels for related records such as Activities, History, Contacts, Opportunities, and Leads. You can create new records or edit existing ones. 
· [bookmark: BM1275907]To export records, check appropriate organizations, click Action -> Export and follow the process described in “Exporting Data”.
· To import records, select Import from the Action bar.
· [bookmark: BM1275911]To merge duplicates, click the Merge Duplicates link and follow the process described in “Merging Duplicate Records”.
· [bookmark: BM1275919][bookmark: BM1275920]To edit an organization, click Edit, make the changes, and click Save.
· [bookmark: BM1275921]To duplicate an organization, on the detail page, click Duplicate, and click Save. The system duplicates the organization and displays its detail page. Duplication is a convenient way of creating a similar organization. You can change the information in the duplicate record to create a new organization.
· [bookmark: BM1275922]To delete the organization, on the detail page, click Delete.
· [bookmark: BM1275923]Click View Change Log to track changes to organization information.
· [bookmark: BM1442260]To view or manage related records in a sub-panel, see “To manage related information in sub-panels”.
[bookmark: _Products_Module_1][bookmark: _Toc314555015]Products Module

This module is to record the Products installed or purchased by any organization. This module will give you the records that which product is on more demand in the market and Service team can use this module to register or log an issue against any Product.

To create a product:

1. In the Action bar, click Create Products. 
2. The system will respond with the form to fill in. The fields to fill in include: 
· Name. Enter the name of the product you are using to create the product.
· User. Select user of the product. By default, the user is you.
· Description. Enter a brief description of the product.
3. Click Save to create the product; click Cancel to return to the product list without saving the product.
Look at the example of filled in “Create Product” form below:


After you save the product, the product’s detail page displays on the screen. You can create activities, history, Installation units, Cases and organization. 




To manage product
· To export records, check off the appropriate product and click Action ->Select Export. 
· To merge duplicates, check off the appropriate products and click Action ->Select Merge.
· To find duplicates a product, on the detail page, clicks Find Duplicates.
· To track changes to the product information over time, click the View Change Log link. 
· To edit or delete information some or all of the products, check off appropriate products, click Action -> Delete.
· To view detail information, click on the product name list. 
· To edit information, on the detail page, click Edit.
· To duplicate a product, on the detail page, click Duplicate
· To delete a product, on the detail page, click Delete.

[bookmark: _Installation_Units_Module][bookmark: _Toc314555016]Installation Units Module 
This module will use in recording the particular product that has been sold to a particular Organization’s Branch. For identification of the products each and every Product’s Serial Number will be recorded here.

To create an Installation Unit:

1. In the Action bar, click Create Installation Units. 
2. The system will respond with the form to fill in. The fields to fill in include: 
· Serial No. Enter the serial number of the unit you are using to create the installation unit.
· Products.  From the drop-down list, select the related product.
· Organizations. From the drop-down list, select the particular organization.
· Installation Site. Enter the installation site of the unit.
· Term Period. Enter the term period of the unit.
· Date of Installation. Select date of the installation unit
· Branches. Select the branches of the installation unit.
· User. Select user of the product. By default, the user is you.
· Description. Enter a brief description of the unit.
3. Click Save to create the unit; click Cancel to return to the installation unit list without saving the unit.
Look at the example of filled in “Create Installation Units” form below:



After you save the units, the unit’s detail page displays on the screen. You can create activities, history, organizations and Cases.

 

To manage installation units
· To export records, check off the appropriate units and click Action ->Select Export. 
· To merge duplicates, check off the appropriate units and click Action ->Select Merge.
· To track changes to the unit’s information over time, click the View Change Log link. 
· To edit or delete information some or all of the units, check off appropriate units, click Action -> Delete.
· To view detail information, click on the unit name the list. 
· To edit information, on the detail page, click Edit.
· To duplicate a unit, on the detail page, click Duplicate
· To delete a unit, on the detail page, click Delete.

[bookmark: _Cases_Module_1][bookmark: _Toc314555017]Cases Module

Use the Cases Module to create, view, manage and import cases into TamTamCRM database as a comma delimited, tab-delimited, or custom delimited file. To import cases, select Import from the Action bar.

To create cases:
1. In the Action bar, click Create Case. 
2. The system will respond with the form to fill in. The fields to fill in include:
· Number. Enter the number of the cases
· Priority. From the drop-down list, specify the urgency of the problem. 
· Status. From the drop-down list, select the status to indicate the current state of the cases such as Draft or Under Review.
· Type. Select categorize of the cases
· Subject. Enter a statement of the problem.
· Organizations. Select the organization of the cases
· Branches. Select the branches of the cases 
· Products. Select the products of the cases
· Resolutions. Enter the results of the investigations into the problem. 
· Descriptions. Enter a clear description of the problem
· Assigned. Enter the name of the individual you want to assign to the record
3. Click Save to create the case; click Cancel to return to the cases list without saving the case.
4. Look at the example of filled in “Create Cases” form below

To manage cases

1. To edit or delete some or all cases, select any cases and click delete from action drop down list.
2. To view the details of a case, click on the case name in the list.
3. To edit the case details, click Edit, make the changes and click Save.
4. To import records, select Import from the Actions bar on the Cases tab.
5. To export information on one or more cases, select any Case List on the Cases Home page, click the Export from the action drop down list.
6. To merge duplicates, click the Merge Duplicates link.
7. To duplicate a case, click Duplicate on the detail page. 
8. To find duplicates, click Find Duplicates on the detail page.
9. To delete a case, click Delete on the detail page.
10. To track changes to the case over time, click the View Change Log link.

[bookmark: _Activities_Module_1][bookmark: _Toc314555018]Activities Module

An activity can be any interaction with colleagues and customers such as a phone call, a meeting, or an email. Use the Activities module to schedule and manage calls, meetings and tasks:




Basically, the activity is related to a record such as an organization or contact.  You can schedule a meeting with one or more contacts to discuss a specific organization or opportunity. When you create the activity, you can specify the record to which it is related. This allows you to view the scheduled activities from the specified record. 

The Action bar displays the following options:

· Log Call. Click this function to schedule a call as described in “Scheduling Calls and Meetings”.
· Schedule Meeting. Click this function to schedule a meeting as described in “Scheduling Calls and Meetings”.
· Create Task. Click this function to create a task as described in “Creating Tasks”.
· Create Note or Attachment. Click this function to create a note or an attachment for a call, a meeting, or a task as described in “Creating Notes and Attachments”.
· View Calls. Click this function to view and manage calls.
· View Meetings. Click this function to view and manage meetings.
· View Tasks. Click this function to view and manage tasks.
· View Notes. Click this function to create or view notes.
· View Calendar. Click this option to view your daily appointments in the calendar
· Import Calls. Click this option to import your calls.
· Import Meetings. Click this option to import your meeting
· Import Tasks. Click this option to import your task
· Import Notes. Click this option to import external data into a note as described in “Importing Data”.

[bookmark: _Scheduling_Calls_and][bookmark: _Toc314555019]Scheduling Calls and Meetings

The Main purpose of this function is to schedule meeting and call. You also can put subject of discussion, the participants, the time period, and the status of the meeting or call you want to create. You can invite the participants immediately or at a later date to attend the meeting. In addition, any notes or attachments can be created at anytime. You can change the status of the record anytime for instance if you have to cancel it for any reason. The Calls page or the Meetings page shows the following sub-panels during creating a call or meeting:
1) Scheduling. This function displays details such as the name of the attendees, the day, and the time of the call or meeting. If other calls or meetings are scheduled, the busy time is blocked out.
2) Add Invitees. Use the Add Invitees sub-panel to find users that you want to invite as described in “To add invitees”.

To schedule a call or a meeting

1. In the Actions bar of the Activities Home page, click Log Call or Schedule Meeting. 
2. Put in any related data in the following fields:
· Subject. Key in the topic of the conversation.
· Status. Choose one of the following status from the drop-down lists provided:
· Planned. Select this option if the call or meeting is approaching.
· Held. Adjust the status from Planned to Held after accomplish the call or meeting.
· Not Held. Change the status from Planned to Not Held if the call or meeting is cancel for any reason.
· Start Date and Time. Click the Calendar icon and select the date; from the adjoining drop-down lists, select the time (hours and minutes).
· Assigned to. Specify the user who is responsible for the call or meeting. By default, it is allocate to the user himself/herself. To assign to other user, click Select to view the list of users, and click the desired user name.
· Duration. Key in number of hours and choose the number of minutes required into the prepared box and from the drop-down list respectively.
· Related To. Optionally, enter the name of the related organization or click Select to search for one. Instead of an organization, you can choose another related record such as an opportunity or contact from the drop-down list.
· Reminder. Select this box if you want the system to send out a reminder to everybody on the list prior to the call or meeting. Select a time for the remainder from the drop-down list below.
· Description. Enter a brief explanation such as the rationale of the call or meeting.
3. Click Save to save the call information; click Cancel to return to the Calls home page or Meetings home page without saving the information:








See an example of the completed “Schedule Call” form below:



4. Click Send Invites to send out an invitation to the participants.
5. To close the page and create a new call or meeting, click Close and Create New.

[bookmark: _To_add_invitees]To add invitees

1. Enter desired information from the list below in the Add Invitees sub-panel:
First Name. You can add an alphabet, a full name, or a partial name.
Last Name. You can add an alphabet, a full name, or a partial name.
Email. You can add an alphabet, a full email address, or just a fractional email address.
2. Click Search. List of results will appear below with Add adjacent to each name on the list.
3. You can send invitation to many users by clicking the Add button beside their names. See below:



Now, in the Scheduling tab, along with you, if you are assigned to this activity, you will see the person who you invited to participate as well. To delete one of the participants, click Del:


[bookmark: _Creating_Tasks][bookmark: _Toc314555020]Creating Tasks

Any tasks created can be assigned to yourself or to other users based on the job related. The task also can be linking to a specific record such as an organization or an opportunity. You can also change the task status and keep it up-to-date.

To create a task

1. In the Action bar of the Activities Home page, click Create Task
2. Enter following information in the specified fields as displayed in Task page:
· Subject. Enter the focus of the task.
· Start Date. Optionally, pick the start date for the task by clicking the calendar image; enter the time in the adjoining box. Choose None box if the task is not related to any date.
· Due Date. Pick the end date for the task by clicking the calendar image; enter the time in the adjoining box. Choose None box if the task is not related to any due date. Enter the dateline information if you want to add the task on your calendar and subsequently receive a reminder when it is due.
· Priority. Choose a priority that reflects the importance of completing the task from the drop-down list.
· Status. Choose the current status of the task, such as Not Started, In Progress, and Completed from the drop-down list provided.
· Related To. Choose any related module with the task from the drop-down list. For instance, say an organization and then click Select to search related organization. 
· Contact Name. Click Select to select a specific individual who is the contact for the task. By default, it is assigned to you.
· Resolution. Select the task resolution.
· Meeting. Select the task meeting
· Note. Select the task note
· Description. Key in a brief explanation of the task.
· Work Log. Enter the work log for these task
· Assigned to. By default, it is allocate to the user himself/herself. To assign to other user, click Select to view the list of users, and then click the desired user name.
· 3. Click Save to create the task; click Cancel to exit the page without creating the task.
See an example of the completed “Create task” form below:



[bookmark: _Creating_Notes_and][bookmark: _Toc314555021]Creating Notes and Attachments

TamtamCRM also allows you to create or import notes connected to a specific call, meeting, or task for sharing to participants. Notes enable you to add comments on a subject and maintain a record of discussions pertaining to a call, meeting, or task and attach any supporting documents to the note.

To create a note or attachment
1. In the Action bar, click Create Note or Add Attachment.
2. Enter information for the following fields as appeared in the Note’s page:
Contact. Put in the name of the contact by click Select to choose one from the Contacts list 
Related To. Optionally, enter the name of the related organization or click Select to search for one. Instead of an organization, you can choose another related record such as an opportunity or contact from the drop-down list.
Note Subject. Key in the matter of the note.
Attachment. Click Browse to attach a document that is located on your computer, navigate it to the location of the file, and then select the file.
Note. Enter the brief description of the note in this box.
3. Click Save to produce the note or attachment or click Cancel to go back to the Notes home page without saving your changes.
See an example of the completed “Create Note or attachment” form below:


[bookmark: _Toc314555022][bookmark: BM1275439]Using Calendar

Use the Calendar module to view and to create activities such as appointments, calls, meetings, and tasks. To view your calendar by day, week, month or year, as well as to view your shared calendar, click the Activity Module at the top of the main screen:




In each format, any planned activities with associated dates are displayed – such as Calls, Meetings, Tasks, Notes and Emails. Icons are used to indicate the type of activity: 
· for a call;
· for a task;
· For a meeting.

[bookmark: BM1275454]This system enables you to click on any activity on your calendar to update the information and move backwards and forwards in the calendar- by one day, week, month or year. You also can click on any date in the week, month or year format to view it in day format 
[bookmark: BM1275484]
You also can create a related note or attachment to the call or meeting. For instance, you can use note to summarize the outcome of a call or a meeting.
[bookmark: BM1275485]Other activities related to a call or a meeting includes creating a task and archiving emails. For more information, see “Activities Module”.
[bookmark: BM1275489]
[bookmark: BM1275493]The calendar record the hours of the day in Day format vertically. Click on a specific time to schedule a call or a meeting at that time, decide what you want to schedule – a call or a meeting – enter the subject name and click on Save:



[bookmark: BM1275503]Optionally, you can create an appointment using the Create Appointment form, which allows you to quickly schedule a call or a meeting. This form only displays the required fields. You can add information for fields after you save the form. 






[bookmark: _Toc314555023]To Create an Appointment
1. [bookmark: BM1275504]In the Create Appointment form, select Schedule Call or Schedule Meeting. 
2. [bookmark: BM1275505]Enter the subject of the call or meeting
3. [bookmark: BM1275506]Click the Calendar icon and select the scheduled date; enter the time in the Start Time field below.
[bookmark: BM1275507] Click Save:

[bookmark: BM1275508]
The Calls detail page or the Meeting detail page displays the information that you entered.

[bookmark: BM1275498]Alternatively, for creating an appointment, you can use the Schedule Call and Schedule Meeting options in the shortcut section as described in “Scheduling Calls or Meetings”.

A list of existing tasks displays on the right side of the main calendar body. To view the details of a task, click its subject title. From the detail view page you can Edit, Duplicate, Delete or Close and Create New call or a meeting:



[bookmark: _Toc314555024]Shared Calendar

Now, the Calendar Module allows you to share your calendar with other employees. Thanks to the special “Shared” tab on the Calendar, this option is enabled. 



The Shared calendar option allows you to see the calendar of other users, and show them your calendar activities planned for a month. You can share the calendar with another user and both of you can see each other activities. Optionally, another user can share his/her calendar with you, but you don’t share yours. Click on “Edit” and select users for calendar display:

Now, on your calendar, you can see a list of activities visible to you and to those with whom you are sharing your calendar:



[bookmark: _Contacts_Module_1][bookmark: _Toc314555025]Contacts Module
[bookmark: BM1555835]Apply the Contacts module to create and monitor contacts for your organization:


[bookmark: BM1275736]A contact is the result of the conversion of valid sales lead; which means any individual that has been evaluated and reviewed for a possible sales opportunity. You can relate a contact with any record available such as an organization, opportunity, or campaign. Relating a contact with a campaign enables you to track the success of the campaign in generating opportunities for your organization.

The Action bar displays the following options:

Create Contact, Create Contact from vCard, View Contacts and Import Contacts




[bookmark: BM1275747][bookmark: _Toc314555026]To Create a Contact
1. [bookmark: BM1275748]In the Action bar, click Create Contact:
2. [bookmark: BM1275757]Fill up the following information on the Contacts page:
· [bookmark: BM1275759]First Name. Key in the contact’s first name.
· [bookmark: BM1275760]Last Name. Key in the contact’s last name.
· [bookmark: BM1275768]Title. Key in the contact’s business title.
· [bookmark: BM1275761]Office Phone. Key in the contact’s work number.
· [bookmark: BM1275762]Mobile. Key in the contact’s cellular phone number.
· [bookmark: BM1275769]Fax. Key in the contact’s fax number.
· [bookmark: BM1275763]Organization Name. Select the organization name related with the contact from the existing lists.
· [bookmark: BM1275783][bookmark: BM1275784]Address Information: Enter the main address and other address information. To copy information from one section to the other, you can enter the address information on either one of the sections and click the arrow buttons. The system automatically enters the address for you if you select a contact from the Contact’s list. However, you can update this information anytime. 
· [bookmark: BM1355652][bookmark: BM1449781]Email Address: Put in an emails address for the contact and then select Primary. If the address is incorrect, select Invalid to specify it. An individual can choose Opted Out to unsubscribe any emails campaign sent out to the individual. Click Add Icon to add an additional email address. You can add multiple email addresses.
· [bookmark: BM1355650]Description Information: Enter a brief description for the contact.
· [bookmark: BM1275778]Reports To. Click Select and select the contact’s supervisor from the Contacts list.
· [bookmark: BM1275765]Lead Source. From the drop-down list, select the source that generated the lead, such as direct mail or trade show.
· [bookmark: BM1275767]Campaign.  Click Select to select it from the Campaigns list in order to associate it with the contacts
· [bookmark: BM1275779][bookmark: BM1275780]Sync to Outlook. Select the box to synchronize this contact data with Outlook after installed TamTamCRM Plug-in for Microsoft Outlook
· Do Not Call. Select this box to put the contact into Do Not Call list to avoid from sent out campaigns to this contact.
· [bookmark: BM1275782]Assigned to. Choose the individual responsible to communicate with this contact. By default, user himself/herself assigned to the contact.
[bookmark: BM1275791]3. Click Save to save the contact; click Cancel to return to the Contact’s home page without creating the new contact.

[bookmark: _To_view_and][bookmark: BM1275793][bookmark: _Toc314555027]To View and Manage Contacts

· [bookmark: BM1275794]To delete one or more of the listed contacts, use the Mass Update panel. To do this, check off appropriate contacts, click Action -> Select Delete.
· [bookmark: BM1275798]Click on the contact name in the list to show the detail view.
· To export records, check off the appropriate contacts and click Action ->Select Export. 
· [bookmark: BM1275807]To edit contact details, in the detail view, click Edit.
· [bookmark: BM1275809]To duplicate contact information, in the detail view, click Duplicate.
· [bookmark: BM1275811]To track modify made to contact information click the View Change Log link placed below the Edit button.
· [bookmark: BM1441546]To manage newsletter subscriptions, click Manage Subscriptions. To add the individual to a newsletter subscription mailing list, select the newsletter from the Available NewsLetters list and drag it to the NewsLetters Subscribed To list and vice versa. Click Save to update the information.
· [bookmark: BM1275814]To manage records in a sub-panel, see “To manage related information in sub-panels”. 
[bookmark: BM1275817]
[bookmark: _Toc314555028][bookmark: BM1275824]Creating Contacts from vCards 

[bookmark: BM1275825][bookmark: BM1275830]You can also create a new contact in TamTamCRM importing a vCard file from your local file system.

To import a vCard:
[bookmark: BM1275831]1. In the choose Create Contact from vCard in the Action bar
[bookmark: BM1275832]2. On click Browse to navigate to the vCard location on the local file system.

[bookmark: BM1275833]3. In the Choose File dialog box, select the file and click Open.
[bookmark: BM1275834]4. The file path displays in the Contacts Import vCard field.

[bookmark: BM1275835]5. Click Import vCard.

See below:



[bookmark: BM1275836]The detail in the vCard displays on a new Contacts detail page.
[bookmark: BM1275837]The system shows a vCard button adjacent to the contact name. Choose this button to open the vCard file and update the information:


[bookmark: BM1275838][bookmark: BM1275839][bookmark: BM1275840]To edit the contact information, click Edit in the Contacts detail page. To duplicate the information, click Duplicate in the Contacts detail page. To delete the information, click Delete in the Contacts detail page.
[bookmark: _Accounts_Module][bookmark: _Organization_Module]
[bookmark: _Calendar_Module][bookmark: _Activities_Module][bookmark: _Toc314555029]Opportunities Module
[bookmark: BM1556003]Use the Opportunities module to create and manage sales opportunities for your organization:
The Action bar displays the following options:
Create Opportunity, View Opportunities and Import Opportunities


[bookmark: BM1276041]
Each opportunity must be connected with only one organization and also enable you to associate it with multiple leads and contacts. The TamTamCRM Systems’ customized functionality also allows assigning opportunities to teams, which helps share the data related to specific opportunities between multiple team members.

To create an opportunity

1. [bookmark: BM1556031]In the Opportunity menu , click Create Opportunity:
[bookmark: BM1276062]
This form contains only the required fields. You can enter information for optional fields after you save the form.
[bookmark: BM1276063]2. On the Opportunities page, enter information for the following fields:
· [bookmark: BM1276064]Opportunity Name. Enter a title for the opportunity.
· Month Yr Log. Select the specific date of opportunities log.
· Age of Opportunity. 
· [bookmark: BM1276076][bookmark: BM1276077]Probability (%). The system determines the rate for this field based on the selected Sales Stage value. However, you also can manually change the Probability % rate.
·  Sector. Select the sector from the dropdown list
· Currency. Select the currency desired from the dropdown list.
· Quantity. Enter quantity of the opportunities.
· [bookmark: BM1276066]Type. Specify whether the opportunity is from an existing customer or a potential customer from the drop-down list,
· [bookmark: BM1276068]Campaign. Click Select to associate an opportunity with a campaign from the Campaigns list.
· [bookmark: BM1276065]Organization Name. Click Select to choose from the list of existing organizations,
· [bookmark: BM1276072]Expected Close Date. Enter the expected or estimated close date for this particular opportunity. 
· Estimate Billing Date. The expected or estimated billing date for this particular opportunity.
· Revised Closed Date. The expected or revised close date for this particular opportunity.
· [bookmark: BM1276074]Sales Stage. The current stage of this opportunity. 
· [bookmark: BM1276067]Lead Source. State the lead source such from the drop-down list.
· [bookmark: BM1276071]Opportunities Amount. Enter the estimated amount of the closing a sale.
· Solution. Select the solution for these opportunities.
· Channel. Enter the channel for these opportunities.
· H/W product. Enter the h/w product for these opportunities.
· [bookmark: BM1276073]Next Step. Specify the next step in closing a sale.
· [bookmark: BM1276070]Assigned to. Enter the name of the individual who is responsible for working on the opportunity. To choose an existing user, click Select, and choose the person from the User List. By default, this is assigned to you.
· [bookmark: BM1276075]The value specified for the Sales Stage determines the default value displayed in the Probability field on the Opportunity page. 
· [bookmark: BM1276078]Description. Enter a brief explanation of the opportunity. 
· When you are done, click on Save.

Look below for an example of the filled in “Create Opportunity” form:


As you click on Save button, the system will take you to the page of the opportunity you have just created. From here, you can connect your opportunity to specific Activities, Leads, Contacts, and Documents by clicking on appropriate Create or Select buttons:


You can learn more about managing related information in sub-panels in “To manage related information in sub-panels”.

When you make all the necessary changes to your opportunity, the system will take you back onto the Opportunities Home page, displaying the list of your opportunities. From here, you can assign your opportunity to a specific team to share it with your team members as well. To do it, check off the appropriate opportunity and click Action ->Select Mass Update, in the Mass Update box select the necessary team from the drop down list and click Update: 




[bookmark: BM1276085]

To manage opportunities
· [bookmark: BM1276089]Click any column title which has the  38.png icon beside it to sort the list view and click the column title again to reverse the sort order.
· [bookmark: BM1276090][bookmark: BM1276094]Use the Mass Update sub-panel to edit or delete some or all the listed opportunities.
· To export records, check off the appropriate opportunity and click Action ->Select Export.
· Click the opportunity name in the list to view the details of an opportunity, 
· [bookmark: BM1276103]Click Edit to edit the details on the detail page.
· [bookmark: BM1276104]Click Duplicate on the detail page to duplicate an opportunity
· Click Delete on the detail page to delete an opportunity
· To find duplicates an opportunity, on the detail page, clicks Find Duplicates.
· [bookmark: BM1276107]To track changes to an opportunity over time, click the View Change Log link.
· [bookmark: BM1276115]To import opportunity data from an external source, see “Importing data”.
· [bookmark: _Leads_Module_1][bookmark: BM1276098]Click the Merge Duplicates link to merge duplicates and follows the process described in “Merging Duplicate Records.”
[bookmark: _Toc314555030]Leads Module

[bookmark: BM1555947][bookmark: BM1275953]Use the Leads module to create and manage sales leads for your organization: 
The Action bar displays the following options:

Create Lead, Create Lead from vCard, View Leads and Import Leads





[bookmark: BM1275954]Leads are potential individual to be contacts according to the opportunity identified in the sales process. After they have been evaluated and assessed, you can convert them into Contacts, Opportunities, and Organizations. Lead can be associated with any type of Campaign to track the effectiveness and subsequently generating opportunities for your organization.

To create a lead

[bookmark: BM1275955]1. In the Lead menu, click Create Leads. 
[bookmark: BM1275964]2. On the Leads page, enter information for the following:
· [bookmark: BM1275971]First Name. Key in the lead’s first name.
· [bookmark: BM1275972]Last Name. Key in the lead’s last name.
· [bookmark: BM1275983]Title. Key in the business title of the lead.
· [bookmark: BM1275984]Department. Key in the department to which the lead belongs.
· [bookmark: BM1275982]Organization Name. Enter the name of the organization related to the lead.
· [bookmark: BM1275973]Office Phone. Enter the lead’s work number.
· [bookmark: BM1275974]Mobile. Key in the lead’s mobile phone number.
· [bookmark: BM1275977]Fax. Key in the lead’s fax number
· Website. Key in the lead’s website.
· Primary Address: Street, City, State, Postal Code and Country
· Other Address: Street, City, State, Postal Code and Country
· [bookmark: BM1355686][bookmark: BM1355688][bookmark: BM1275965]Address Information. Enter the primary address and other address information. To copy the other address from the primary address, select the Copy address from left checkbox.
· [bookmark: BM1449805]Email Address. Enter an emails address, contacts and campaign targets within the organization. If an email address is incorrect, select Invalid to specify it. The leads can select Opted Out. To add additional email addresses, click Add Address.
· [bookmark: BM1275966]Lead Source. Select the origins of the lead from the drop-down list.
· Lead Source Description. Enter a brief explanation of the lead source.
· [bookmark: BM1275967]Status. From the drop-down list, select the status of the lead such as New or In Process.
· [bookmark: BM1275968]Status Description. Enter a brief explanation for the lead status.
· Opportunity Amount. Enter the opportunities amount for these leads. 
· [bookmark: BM1275969]Campaign. To associate the lead with a campaign, click Select to select it from the Campaigns list.
· [bookmark: BM1275970]Referred by. Enter the information in this field if someone referred the lead to you,
· [bookmark: BM1275980]Email Opt Out. Select this box if the lead opted to not share their email address with you.
· [bookmark: BM1275981]Invalid Email. If an email address is invalid, select this box
· [bookmark: BM1275985]Do Not Call. Check this box to add the lead’s name to the Do Not Call list to avoid the lists from targeted during campaigns.
· [bookmark: BM1275987]Assigned to. Enter the name of the individual who is responsible for the lead. To choose an existing user, click Select, and choose the person from the User List. By default, this is assigned to you.
· [bookmark: BM1275990]Description. Enter a brief explanation for the lead.
2. [bookmark: BM1275991]Click Save to save the new lead information or click Cancel to return to the Leads home page without saving the information. See the example of the completed “Create Lead” form below:



[bookmark: BM1275992]After you save the lead, the lead’s detail page displays on the screen. You can create activities and view past marketing activities including a list of any campaigns that were sent out to the lead.
[bookmark: BM1275994]Managing Lead Information
[bookmark: BM1275995]You can manage and track leads through their life-cycle. 

[bookmark: BM1275996]To manage leads
· [bookmark: BM1275997]To search for a lead, use the Search sub-panel on the Leads Home Module as described in “Searching for Information on TamTamCRM”.
· [bookmark: BM1276001][bookmark: BM1276005]To export records, check off the appropriate leads and click Action ->Select Export. 
· To merge duplicates, check off the appropriate leads and click Action ->Select Merge and follow the process described in “To merge duplicate records”.
· To find duplicates a lead, on the detail page, clicks Find Duplicates.
· [bookmark: BM1276009]To track any modification to the lead information over time, click the View Change Log link. 
· [bookmark: BM1276010]To edit or delete information some or all of the leads, check off appropriate leads, click Action -> Delete.
· [bookmark: BM1276014]To view detail information, click on the lead name from the list. 
· [bookmark: BM1276015]To update information, on the detail page, click Edit.
· [bookmark: BM1276016]To monitor newsletter subscriptions, on the detail page, click Manage Subscriptions. To add the individual to a newsletter subscription mailing list, select the newsletter from the Available Newsletters list and drag it to the Newsletters Subscribed To list and vice versa Click Save to update the information.
· [bookmark: BM1276017][bookmark: BM1276018]To duplicate a lead, on the detail page, click Duplicate. 
· [bookmark: BM1276019]To delete a lead, on the detail page, click Delete.
· [bookmark: BM1276020]To convert a lead to a contact, click Convert Lead. Optionally, you can also convert the lead to a related Organization, Opportunity, and Appointment.
· [bookmark: BM1276023]To view and edit associated information in a sub-panel, see “To manage related information in sub-panels”.

[bookmark: BM1276025]Note: 	You can create Web-to-Lead forms for apply in Web-based campaigns and other sources such as your Website or blog. This Lead information is saved in the TamTamCRM database and can be used to produce opportunities for your organization. For more information, see “Creating Web-to-Lead Forms”.

[bookmark: _Documents_Module][bookmark: _Toc314555031][bookmark: BM1443605]Documents Module
[bookmark: BM1556167]Main purpose of Documents module is to create and manage files that you share with users and contacts.
[bookmark: BM1276652]
To create a document:

1. In the Action bar, click Create. 
2. The system will respond with the form to fill in. The fields to fill in include: 

· File Name. Enter the title of the file you are using to create the document; click Browse to navigate to the location of the document and select the file. 
· Status. From the drop-down list, select the class to indicate the current state of the document 
· Document Name. Enter a name for the document.
· Revision. Enter the revision number each time you revise the document.
· Document Type. Select a pre-defined document from the drop-down list
· Template. Select this box if you are making a template.
· Publish Date. Click the Calendar icon and select the date when the document is available for other users to view and download.
· Category. Select a pre-defined category from the drop-down list. 
· Sub Category. If you selected a category, select the category subset if applicable.
When you select a Category and Sub Category for the document, the document will be added added to the Document tree using a hierarchical structure. The tree structure only displays in the list view and helps organize the files and makes it easier to find documents under a specific subject. The values listed in Categories and Sub Categories are defined by the administrator.
· Expiration Date. Click the Calendar icon and choose the date when the validity of the document expires.
· Related Document. Click Select to relate a related document.
· Related Document Revision. From the drop-down list, select the revision number of the related document.
· Description. Enter a brief explanation of the document.
3. [bookmark: BM1276677]Click Save to create the document or Cancel to return to the document list without saving the document.
4. Look at the filled in example of “Create Document” herein below:

 
[bookmark: BM1276678]The file will now be displayed in the documents list as well as on the detail page in the Download File field. Click the attachment to open or save it to your computer. 

[bookmark: BM1276680]To manage documents 
· [bookmark: BM1276684]To sort a list view, click any column title which has the  38.png icon beside it or to reverse the sort order, click the column title again.
· [bookmark: BM1276685]To edit or delete some or all the documents, apply the Mass Update panel.
· [bookmark: BM1276689]To view the details of a document, on the Documents module, click its name; links to attachments, if any, are displayed below Description.
· [bookmark: BM1276690][bookmark: BM1276694]Click the attachment link to view an attachment.
· To update a document, on the detail page, click Edit.
· [bookmark: BM1276695]To copy a document, on the detail page, click Duplicate.
· [bookmark: BM1276697]To remove a document, on the detail page, click Delete.
· [bookmark: BM1276698][bookmark: BM1276699]To track any modification to the document, click the View Change Log link below the Edit button.
· To export documents, select in the Document List sub-panel on the Documents Home page, click the Export icon, and export them as described in “Exporting Data”.


[bookmark: BM1276708]To update an attachment

1. [bookmark: BM1276709] Click Create in the Document Revisions sub-panel of the document’s detail page: 



2. [bookmark: BM1276710][bookmark: BM1276711]The Documents Revision page, the current document name and revision number appear on this page. 
3. Put in the related information for the following fields:
· [bookmark: BM1276712]FileName. Enter the title of the file containing the revised information; to navigate to the file location, click Browse.
· [bookmark: BM1276713]Revision. State a revision number for the revised document.
· [bookmark: BM1276714][bookmark: BM1276715]Change Log. Enter a brief explanation of the revision.
4. Click Save to save your changes or click Cancel to go back to the document detail page without saving the changes. See the example of the filled in form below: 



[bookmark: BM1276716][bookmark: BM1276717]Name of the attached file can’t be changed and the revised file is displayed along with its revision number in the Documents Revisions sub-panel. In this sub-panel, it list all the older document version and displays the rem icon to delete the file. To delete the previous version of the attachment, click the rem icon, and click OK to confirm the removal:

[bookmark: _Opportunities_Module][bookmark: opo][bookmark: _Contacts_Module][bookmark: _Dashboard_Module][bookmark: _Reports_Module][bookmark: _Products_Module]
[bookmark: _Emails_Module][bookmark: _Installation_Units][bookmark: _Email_Module][bookmark: _Toc314555032]Email Module
[bookmark: BM1348697]The Emails module allows you to manage your emails:


[bookmark: BM1468671]
[bookmark: BM1045753]You can use the new Emails module as an email client to manage your inbound and outbound emails. You can send the emails that you compose in TamTamCRM through any of your external mail account.
[bookmark: BM1045762]In addition, the Emails module offers the following features:
· [bookmark: BM1045754]Ability to create Group folders to route emails for distribution. 
· [bookmark: BM1045755]A default personal folder named My Emails. You can create additional personal folders.
· [bookmark: BM1045758]Ability to create records such as bugs and leads from inbound emails.
· [bookmark: BM1050736]Ability to create an address book with entries from your list of users, contacts, and leads.
· Ability to import emails. You can import emails into TamTamCRM from external mail servers. The Emails module provides a folder named My Email for this purpose. You can associate an imported email with a TamTamCRM record such as a bug or an organization. This creates a thread of email communication related to that record for future reference.

[bookmark: BM1468726]In addition, you can perform the following actions in the Emails module:
· [bookmark: BM1468727]Search for emails based on parameters, such as keyword and subject.
· [bookmark: BM1468728]Create a related record, such as a bug or a lead, from an email.
· [bookmark: BM1468731]Create an address book consisting of users, contacts, and leads with whom you frequently communicate.

[bookmark: BM1348740][bookmark: _Toc314555033]Setting up Your Mail Account

[bookmark: BM1348741]You will need to set up a mail account in TamTamCRM for every external mail account that you want to access through TamTamCRM. You must set up at least one mail account in TamTamCRM to be able to send and receive emails. 








[bookmark: BM1348748]To create a mail account

1. [bookmark: BM1348749]Click Settings at the top of the page:



[bookmark: BM1438872]
2. [bookmark: BM1357915]Select My Accounts and click Add on the Settings page:




[bookmark: BM1348755]3. Enter the following information to create a new mail account:
· [bookmark: BM1348756]Mail Account Name. Enter a name for the account.
· [bookmark: BM1470065]User Name. Enter your user name.
· [bookmark: BM1470071]Password. Enter your user password.
· [bookmark: BM1348759]Mail Server Address. Enter the address of the email server from which your emails will be routed to TamTamCRM. To access a Gmail account, click Prefill Gmail.
· Default. To auto fill the mail server port number and protocol.
· [bookmark: BM1348765]Use SSL. Select this box if you are using POP3 and your external mail account requires SSL.
· [bookmark: BM1348762]Mail Server Protocol. From the drop-down list, select either IMAP or POP3.  
· [bookmark: BM1348763]When you create an account for an external mail account such as Yahoo or Google, you must ensure that you are using their mail server protocol. 
· [bookmark: BM1348764]Mail Server Port. The system automatically populates this field with the port number for the selected protocol.
· Monitored Folder. This field only appeared when you select IMAP as the protocol. By default, the system monitors the inbox. Click select to view a list of folder for others monitored folders. 
· Trash Folder. To select a trash folder from the folder record, click Select. After that, click OK. 
· Sent Folder. To add sent folder to view your outbound emails, click select.  After you specify a folder, click OK.
4.  Click test setting to ensure that the setting are correctly configured	
In the Outgoing Email section, put in the following information:
· [bookmark: BM1348757]From Name. Enter the name of the sender.
· [bookmark: BM1348758]From Address. Enter the sender’s address.
· Reply to Address. Enter the sender’s reply address
· [bookmark: BM1348766]Outgoing SMTP Mail Server. From the drop-down list, select a mail server for outbound emails or add new SMTP Mail Server. 
[bookmark: BM1348771]5. Click Done to create the mail account. or cancel without save your information.
6. Click Clear Form to reset filled data.
7. To close window, click close

[bookmark: BM1348773]To add a mail server for outbound emails

[bookmark: BM1348774]1.  Click the Add button located next to the Outgoing Mail Server drop-down list:



[bookmark: BM1348778]The Outbound Mail Server page appeared on the screen.  The Outbound Mail Server Properties page displays on the screen. You can choose Gmail, Yahoo, Exchange, or Other. 

1. [bookmark: BM1348779]Enter information for the following fields:
· [bookmark: BM1348780]Name. Enter a name for the account.
· [bookmark: BM1348781]SMTP Server. Enter the SMTP mail server’s address.
· [bookmark: BM1348782]SMTP Port. Enter the mail server’s port number.
· [bookmark: BM1348783]To add Google’s Gmail server, click Set Gmail Defaults. The system fills in the SMTP Server and SMTP Port fields with the Gmail server address and port number respectively.
· Enable SMTP over SSL or TSL. Select this option if you are using the POP3 protocol and the mail server requires SSL.
· [bookmark: BM1348785]Use SMTP Authentication. Select this option if the mail server requires authentication to send out the email.
· [bookmark: BM1348786]SMTP Username. Enter your username for the mail account.
· [bookmark: BM1348787]SMTP Password. Enter your password for the mail account.
2. [bookmark: BM1360056]Click done to add the mail server; click Cancel if you do not want to add the mail server.
3. Click Test Settings to ensure that the settings are correctly configured.
See the example of a mail server settings page completed:



After you have created your email account and added a mail server for outbound mails, you can start working with your emails. The procedure of working with Emails Module in TamTamCRM has very much in common with using other email clients.

[bookmark: _Archiving_Emails][bookmark: _Toc314555034]Compose an Email
1. To compose an Email, on the emails home page, click Compose Email.
2. To compose an email, enter information for the following fields;
From. Enter the name of the individual who sent out the email.
To. Click this button to select recipients from the address book, or manually enter the email address of recipients in the field.
Bcc. Click this button to select recipients from the address book, or manually enter the email address of recipients in the field.
Subject. Enter the topic of the email.
Attach. Click this button to attach a file that is located on your machine. You can enter the path to the file or click Browse to navigate to the file.
Plain Text. Select this box to display the email in text format if an email client cannot render HTML code.
Option. To populate the email with the contents of an email template 
3. Click Send to send the email
[bookmark: BM1349052]
[bookmark: _Creating_Email_Templates][bookmark: _Toc314555035]Creating Email Templates

[bookmark: BM1349053]You can apply email templates to create form letters for automated email responses to inbound emails and for mass email campaigns. For instance, when you receive an inbound email regarding a bug or a case, you can send out automatic reply stating that the matter will be addressed.

[bookmark: BM1349054]Whereas, for email campaigns, enter the message in the template and then specify the variables such as the target names and addresses from the campaign target list. The system inserts these variables into the template in order to create a personalized email for every target. You can embed images and attach files from the TamTamCRM repository or from your local file system when creating an email template.
[bookmark: BM1349055]Besides, you also can insert tracker URLs into the template to track campaign movement. For further information on email campaigns, click “Executing an Email Campaign”.
[bookmark: BM1556300]
You can use email templates to create automated responses when you receive inbound emails regarding a specific topic such as a bug or a case.
 
[bookmark: BM1349067]To create an email template:

[bookmark: BM1349068]1. In the Action bar, click Create Email Template and you will see the form to fill in:


[bookmark: BM1349069]2. Enter information for the following fields:
· [bookmark: BM1349070]Name. Enter a title for the template.
· Assigned To. To assign the template to desired user, click the arrow button and select from the list of users.
· [bookmark: BM1349072]Description. Enter a brief explanation about the template.
· [bookmark: BM1349073][bookmark: BM1349074]Insert Variable. From the drop-down list, select a record such as contact and select a field such as Full Name and then click Insert. The system will show the variable in the Body field. 
[bookmark: BM1349075]3. Insert Tracker URL. This field shows only when you create the template from the email marketing record of an Email campaign. Select the tracker URL to insert and click Insert URL Reference from the drop-down list. 
[bookmark: BM1349076]The Body field displays a link named Default link text. The adjacent field displays the tracker name for plain text format. 
[bookmark: BM1349077]4. Subject. Enter the subject of the message.
[bookmark: BM1349078][bookmark: BM1349082]5. Body. Enter the email content also can embed images and add URL links. To view and apply the HTML editor, click HTML in the Body field. 
[bookmark: BM1473564]6. To use standard formatting options such as font face, size, bold, italics, indentation and color, highlight the text and select the appropriate option in the Body field.
[bookmark: BM1473565]7. Send Text only. Select this box to display the email in plain text format and if an email client cannot render HTML code. 

[bookmark: BM1473567]8. Attachments: 
[bookmark: BM1349098][bookmark: BM1349111][bookmark: BM1349117]To attach a file, including images, click Browse to navigate to its location on your local machine.  The attached files displays below the Browse button. 
9. TamTamCRM Document. Click this button to attach a document from the TamTamCRM repository; when you select the file from the Documents List, the system attaches it to the email template.
[bookmark: BM1349118]10. Click Save to create the template; click Cancel to exit the page without saving your changes.
	
[bookmark: BM1349119]To manage email templates

· [bookmark: BM1349120]To search for a template, enter the name or description in the Search sub-panel on the Email Templates page, and then click Search.
· [bookmark: BM1349121]To see the details of a template, click the template name from the list on the Email Templates page.
· [bookmark: BM1349122]To update the template, on the detail page, click Edit, make the changes, and click Save.
· [bookmark: BM1349123]To copy the template, on the detail page, click Duplicate and click Save.
· [bookmark: BM1349124]To remove the template, on the detail page, click Delete; to delete some or all the templates, select them from the list on the Email Templates Home page, and click Delete.
· [bookmark: BM1349125]To export one or more templates, select the templates from the list on the Email Templates Home page, and then click Export.
· [bookmark: BM1349126]To deselect templates that you selected in the list, click Clear All.

[bookmark: _Campaigns_Module][bookmark: _Toc314555036]Campaigns Module
[bookmark: BM1556328]Apply the Campaigns Module to track and monitor mass marketing campaigns:

 

[bookmark: BM1276940]Normally, a mass marketing campaign targets a large group of individuals or organizations. So, the campaign process begins with identifying the targets, and then group multiple targets into a target list according to a set of predetermined criteria such as age group or spending habits. 


[bookmark: _Creating_and_Importing][bookmark: BM1276943][bookmark: _Toc314555037]Creating and Importing Campaign Targets
[bookmark: BM1276944]A target is an individual that you have some details on but does not meet the criteria as a lead or contact. Targets are separate records that are not attached to contacts, leads, or opportunities. However, you can insert contacts, leads, and users to a campaign’s target list. 
[bookmark: BM1276945]You can add targets to a target list by importing them from a file (either CSV or TSV) or by selecting them from existing contacts and leads. For information on importing targets, see “Importing Data”.
[bookmark: BM1276949]Usually, user can create or import a target list first, associate it with targets, and then associate it with a campaign. However, user can also create a campaign first and then associate it with a target list. 
[bookmark: BM1276964]The general practice is as follows:
 
[bookmark: BM1276965]
[bookmark: BM1276976]A target list can specify either individual who needs to be included or excluded from a campaign.

To create a target list

[bookmark: BM1276977]1. From the Actions bar on the Campaigns Module, click Create Target List.
[bookmark: BM1276978]2. On the Target Lists page, insert the following information:
[bookmark: BM1276979]Name. Enter a title for the target list.
[bookmark: BM1276980][bookmark: BM1276966]Type. From the drop-down list, select the type of the target list: 
· Default. A list of people who are the campaign targets and accept the campaign email.
· [bookmark: BM1276967]Seed. A list of people who need to receive the campaign email but must not be followed as potential leads. Usually, these are individuals who need to approve the campaign before it is launched.
· [bookmark: BM1276968]Test. A list of people who receive the campaign email to test how different email clients appear in the campaign message before you send it out to the default list. 
· [bookmark: BM1276969][bookmark: BM1276981]Suppression List. A list of people to be excluded from the campaign email recipient list. Normally, these are people who chose to opt out of receiving your campaign message. 
· Assigned to. Enter the name of the user assigned to this list; click Select to select from the User list. By default, it is assigned to you.
[bookmark: BM1276983]Description. Enter a brief description of the target list.
[bookmark: BM1276984]3. Click Save to save the target list or Cancel to exit the page without creating the list.

[bookmark: BM1276985]To create a target
[bookmark: BM1276986]1. In the Action bar, click Create Target. 
[bookmark: BM1276995]Note: 	Targets are separate records that are not attached to Contacts or Leads. If you plan to send emails to existing Contacts or Leads, you can leave out the step below.
[bookmark: BM1276996]2. On the Targets page, enter information for the following fields:
· [bookmark: BM1276998]First Name. Key in the target’s first name.
· [bookmark: BM1276999]Last Name. Key in the target’s last name.
· [bookmark: BM1277000]Office Phone. Enter the target’s offive number.
· [bookmark: BM1277001]Mobile. Key in the target’s mobile phone number.
· [bookmark: BM1277004]Fax. Key in the target’s fax number.
· Title. Enter the target’s title.
· [bookmark: BM1449727]Department. Insert the name of the department to which the target belongs to.
· [bookmark: BM1449729]Organization Name. Enter the name of the organization connected to the target.
· [bookmark: BM1449730]Do Not Call. Select this box to add the target’s name to the Do Not Call list.
· [bookmark: BM1449732]Assigned to. Select the user who is responsible to the target.
· [bookmark: BM1449710][bookmark: BM1449765]Email Address. Enter one or more email addresses for the contact and select Primary. If an email address is incorrect, select Invalid to indicate it. Individual can choose Opted Out to opt out from the campaign.To add additional email addresses, click Add Address.
· [bookmark: BM1449749]Address Information. Enter the primary address and other address information. To copy information from one section to the other, you can enter the address information and click the arrow buttons.
· [bookmark: BM1277025]Description. Enter a brief explanation of the target.
[bookmark: BM1277026]3. Click Save to create the target or Cancel to exit the page without creating the target.
[bookmark: BM1277027]See an example of the completed “Create Target” form below:


After saved the target, the target’s detail page displays the Campaign Log sub-panel which lists all the campaigns sent to the target.

[bookmark: _Creating_a_Campaign][bookmark: BM1277030][bookmark: _Toc314555038]Creating a Campaign
[bookmark: BM1277031]You can create a campaign using the Campaign Classic or the Campaign Wizard option. Campaign Classic option allows you to create campaign record but you are not completing related tasks such as specifying the email settings. For more information on creating a campaign using the Classic option, see “Creating a Campaign”. 

[bookmark: BM1285746]Whereas for the Campaign Wizard, it guides you through the process of creating the campaign as well as completing related tasks. For more details on creating a campaign with the Campaign Wizard, see “Using the Campaign Wizard”.

[bookmark: BM1277038]The Campaigns module gives an embedded Return on Investment (ROI) form that with purpose to gauge the success of an executed campaign. For more information, see “Viewing a Campaign’s Return on Investment”.
[bookmark: BM1277042]


Types of Campaigns
[bookmark: BM1277043][bookmark: BM1285942][bookmark: BM1285943]You can create many kinds of marketing campaigns such as Email, Newsletter, Mail, Web, Radio, Television, Print, and Telesales. A campaign such as Mail and Radio allows you to record it in TamTamCRM for your reference but cannot execute the campaign through TamTamCRM. Only Email campaign or a Newsletter campaign can be executed through TamTamCRM. In an Email campaign, you send out a one-time email with the information that is of interest to your targets. In a newsletter campaign, you email a newsletter to your targets on a regular basis. For example, a newsletter can include information on product updates. You can send out a newsletter on a weekly, monthly, quarterly, or yearly basis. To determine the campaign’s success, you can view statistics such as the number of targets that responded the number of opportunities that were created, and the generated revenue. 

[bookmark: BM1277047]The status of the launched Email or Newsletter campaign can be review to know the success. For instance, you can view how many targets viewed the campaign email, how many clicked any links that were included in the email, and how many leads and contacts were created from the campaign. For further information, see “Managing Campaigns”.

[bookmark: BM1277051]To capture leads from an email or a newsletter campaign, you also can create a Web-to-Lead form. For more information, see “Creating Web-to-Lead Forms”.

[bookmark: BM1277055]In addition, for Email campaigns, you can insert images in your email templates instead of sending them as attachments. This avoids your emails from being reported as spam. For more information on embedding images, see “Creating Email Templates”.

[bookmark: BM1277059]A campaign diagnostic tool is provided to help you ensure that all pending administrative tasks, such as setting up a bounce-handling inbox, have been finished. For more information, see “Using the Campaign Wizard”.
[bookmark: BM1277063]Note: 	You must be an administrator to use the Email Setup option that showss in the Action bar.

[bookmark: BM1277065]To create a campaign (Classic)
1. 	Select Create Campaign (Classic) from the action bar. 
[bookmark: BM1277074]2. 	Insert information for the following fields:
· [bookmark: BM1277075]Name. Enter the campaign title.
· [bookmark: BM1277078]Status. From the drop-down list, select the current status of the campaign. 
· [bookmark: BM1277079]Start Date. Click the Calendar icon and select the date on which the campaign starts.
· [bookmark: BM1277080]End Date. Click the Calendar icon and select the date on which the campaign finished.
· [bookmark: BM1277082]Type. From the drop-down list, select the campaign type. For further information on email campaigns, see “Executing an Email Campaign”.
· [bookmark: BM1277086]Currency. From the drop-down list, select the currency used to state the budget, cost, and revenue.
· [bookmark: BM1277076]Assigned to. Enter the name of the user assigned to the campaign; to choose a user from the Users list, click Select, and click the user name.
· [bookmark: BM1277081]Note: The Start Date, Finish Date, and Status values are for own records only. These values do not impact the execution of an email marketing campaign.
· [bookmark: BM1277087]Impressions. Enter the number of page impressions generated from the campaign. You will need to fill in this field after the campaign has begun.
· [bookmark: BM1277088]Budget. Enter the budget provide for the campaign.
· [bookmark: BM1277089]Actual Cost. Enter the actual cost incurred to carry out the campaign.
· [bookmark: BM1277090]Expected Revenue. Enter the expected revenue from the campaign.
· [bookmark: BM1277091]Expected Cost. Enter the expected cost of the campaign.
· [bookmark: BM1277092]Objective. Explain the aim of the campaign.
· [bookmark: BM1277093]Description. Enter a brief explanation of the campaign.



See an example of the completed “Create a Campaign” form below:


[bookmark: BM1277094]3. 	Click Save to save the campaign or Cancel to return to the Campaigns home page without creating the campaign.

[bookmark: BM1277095]After you click on Save, the system displays the campaign’s detail page. The detail page of an email campaign or a newsletter campaign displays sub-panels for targets, tracker URLs, and email marketing. You can create and view any of this information from the respective sub-panels. 

[bookmark: _Executing_an_Email][bookmark: BM1277098][bookmark: _Toc314555039]Executing an Email Campaign

[bookmark: BM1277099]The process of executing an email campaign consists of the following steps:
[bookmark: BM1277103]1. Create an email campaign as described in “To create a campaign”. On the other hand, you can use the campaign wizard to create the campaign as described in “Using the Campaign Wizard”. The Campaign wizard will lead you through the steps listed below.
[bookmark: BM1277109]2. Identify the targets as described in “Creating and Importing Campaign Targets”. You can import targets, or create a new target list, or merge with existing target list. You can also select individuals from a lead report or a contact report.

[bookmark: BM1277111]3. Create an email template including the message you want to convey to your targets. For more information, see “Creating Email Templates”. 
[bookmark: BM1277115]4. Specify an inbox for bounce-handling. This is required to handle campaign emails that bounce back to you. Only administrators can set up mailboxes for inbound emails. When you create a bounce-handling inbox, all bounced campaign emails are routed to that inbox. Bounced emails contain specific identifiers that enable you to tell them apart from emails that are responses from your targets. 
[bookmark: BM1277117]5. Create email marketing records that indicate information such as the target list, the email template, the campaign start date, and the bounce-handling inbox. For more information, see “Creating Email Marketing Records”.
[bookmark: BM1277121]6. Optionally, specify one or more Tracker Redirect URLs to follow up campaign activities. For more information, see “To create a tracker redirect URL”.

[bookmark: BM1277125]7. Optionally, run the diagnostic tool to make sure that the email campaign will be successfully executed. For more information, see “Running Campaign Diagnostics”.
[bookmark: BM1277129]8. Send a test email to your test list to ensure the operation is successful. For more information on test lists, see “Creating and Importing Campaign Targets”.

[bookmark: BM1277133]9. Clear statistics from the test email.
[bookmark: BM1277134]10. Ask for the administrator to schedule a job to send out the campaign emails.

[bookmark: BM1277135]11. 	Queue the email for the campaign launch.
[bookmark: BM1277136]12. Besides, you also can convert the campaign targets into leads or contacts.
[bookmark: BM1277137]
[bookmark: BM1277141]You can connect a Web-to-Lead form with the campaign. For more information, see “Creating Web-to-Lead Forms”. After you commence an email campaign, you can view the campaign status for information on the campaign results. For more information, see “Viewing Campaign Status”.
[bookmark: BM1277145]Note: 	The start date, start time, and status specified on the email marketing page determine when the email is sent.
[bookmark: BM1277148]
[bookmark: _Creating_Email_Marketing][bookmark: _Toc314555040]Creating Email Marketing Records
[bookmark: BM1277149]When you create an email campaign, you must also create an email marketing record that including information such as the campaign target list, the campaign email template, and the inbox to handle emails that bounce back to you. You must specify the email marketing start date and time that is in the past to queue it for delivery. Any emails that rebound are sent to the “From Address” defined in this record.

[bookmark: BM1277150]To create an email marketing record

[bookmark: BM1277151]1. On the campaign’s detail page, scroll down to the Email Marketing sub-panel and click Create:



[bookmark: BM1277155]2. On the Email Marketing page, insert information for the following fields:
· [bookmark: BM1277156]Name. Key in a name for the record.
· [bookmark: BM1277157]Status. From the drop-down list, select Active if the record is in use or Inactive if the record is not in use. Only active records will be queued for campaign launch.
· [bookmark: BM1277158]Use Mailbox. From the drop-down list, choose a mailbox that is set up for Bounce Handling.
· [bookmark: BM1277159]From Name. Key in the name of the organization or person that is sending out the email.
· [bookmark: BM1277160]Start Date & Time. Click the Calendar icon and select a date to send out the email. Enter the time in the adjacent field. 
· [bookmark: BM1277161]Note: To queue the email for campaign launch, select a date and time that has already passed. You be supposed to do this after you ensure that the test email was successful.
· [bookmark: BM1277162]Email Template. From the drop-down list, select an existing email template; to create a new template or edit an existing one, click the adjoining Create or Edit link respectively. 
· [bookmark: BM1277163]You need to edit the template to add the Tracker URLs described below into Text and HTML formats.
· [bookmark: BM1277164]Send This Message to. Select target lists from the box below and to send it to all the target lists in the box, select the All Target Lists in the Campaign box.

See an example of the completed “Create email marketing record” form below:


[bookmark: BM1277165]3. To save the record, click Save or Cancel to exit the page without saving your changes.
[bookmark: BM1277168]
[bookmark: _Creating_Tracker_Redirect][bookmark: _Toc314555041]Creating Tracker Redirect URLs
[bookmark: BM1277170]You can use URLs in your campaign emails to track the answer to your campaign. The system generates a unique key for each URL and for each recipient and associates it with the email template. When recipients open the email and click on a URL link, the system can track each action by each recipient. 

[bookmark: BM1277172]Note: 	You are supposed to check with your system administrator to ensure that the outbound email process is configured to send email from your system as described in Configure System section and Mass Emailing section.

[bookmark: BM1277174]To create a tracker redirect URL
[bookmark: BM1277175]1. On the Campaign’s detail page, scroll down to the Tracker URLs sub-panel, and click Create. 
[bookmark: BM1277179]2. On the Campaign Trackers page, enter information for the following fields:
· [bookmark: BM1277180]Tracker Name. Enter a tracker name for your reference by using alpha-numeric characters.
· [bookmark: BM1277181]Tracker URL. Enter the tracker URL such as http://www.tamtamcrm.com/trial.
· [bookmark: BM1277182]Opt-out Link? Select this box to embed your “Unsubscribe” instructions in a tracker URL. By default, the system uses the removeme.php file which contains these instructions, and displays this file name in the Tracker URL field.
See an example of the completed field below:

[bookmark: BM1277187]3. 	To create the campaign tracker, click Save or Cancel to exit the page without saving your changes.

[bookmark: _Using_the_Campaign][bookmark: BM1277195][bookmark: _Toc314555042]Using the Campaign Wizard
[bookmark: BM1277196]You can use the campaign wizard to guide you through the process of completing a campaign. 
[bookmark: BM1277198]1. In the Actions bar of the Campaigns module, click Campaign Wizard.
[bookmark: BM1277202]The Campaign wizard appears on the screen.
[bookmark: BM1556430]2. Select the type of campaign you want to create and click Start. The screen below illustrates a Newsletter campaign:

[bookmark: BM1277212]3. Enter information for the following fields:
[bookmark: BM1277213]Name. Enter the campaign name.
[bookmark: BM1277214]Status. From the drop-down list, select the current state of the campaign.
[bookmark: BM1277215]Assigned to. Enter the name of the user who is assigned to the campaign. To select from the Users list, click Select. By default, it is assigned to you.
[bookmark: BM1277217]Type. If you are creating a non-email campaign, select the campaign type from the drop-down list.
[bookmark: BM1277218]Frequency. From the drop-down list, select the intervals at which the newsletter will be emailed to targets.
[bookmark: BM1277219]Start Date. Click the Calendar icon to select the date to enter the campaign start date.
[bookmark: BM1277220]End Date. Enter the campaign end date; click the Calendar icon to select the date.
[bookmark: BM1277221]Description. Optionally, enter a brief description of the campaign. 

Click Next. See below:


[bookmark: BM1277225][bookmark: BM1277226]4. 	A Click on Next takes you to the campaign budget information page. Enter information for the following fields:
· [bookmark: BM1277227]Budget. Enter the campaign budget.
· [bookmark: BM1277228]Actual Cost. Enter the actual cost of the campaign.
· [bookmark: BM1277229]Expected Cost. Enter the expected cost of the campaign.
· [bookmark: BM1277230]Expected Revenue. Enter the estimated revenue from the campaign.
· [bookmark: BM1277231]Currency. From the drop-down list, select the currency used for the campaign.
See below for an example of the completed form:




[bookmark: BM1277236]5. Click Next. On the “Campaign Tracker URLs” page, enter information for the following fields:
[bookmark: BM1277237]Tracker Name. Enter a tracker name.
[bookmark: BM1277238]Opt-out link? Select this box to create an opt-out tracker that allows targets to unsubscribe from your email campaigns.
[bookmark: BM1277243]Tracker URL. Enter the tracker URL. For more information, see “Creating Tracker Redirect URLs”.
[bookmark: BM1277245][bookmark: BM1277246][bookmark: BM1277247]6. Click Create Tracker. The new tracker displays below. To create additional tracker URLs, click Create Tracker again and enter the new tracker information.

See an example of the completed form below:



[bookmark: BM1277248]7. Click Next.
[bookmark: BM1277249][bookmark: BM1277256]If you want to create an email campaign or a non-email campaign, the Target Lists screen displays on the screen.  If you are creating a newsletter campaign, the Subscription Information page displays, as in our case:



[bookmark: BM1277257]a.      Click Select and use the Search panel to find the list to use an existing target list,
[bookmark: BM1277258][bookmark: BM1277259]b.       Enter the Target List Name field and select the type from the adjoining Target List Type field to create a new target list. The target list name displays below. 
[bookmark: BM1277260]8. 	     For newsletters, you must create the following three subscription lists:
[bookmark: BM1277261]Subscription list: These targets receive the newsletter regularly.
[bookmark: BM1277262]Unsubscription list: These targets are those who have chosen to opt-out of your mailing list.
[bookmark: BM1277263]Test list: These targets are the recipients of the test email that you send out to ensure it is successful.


[bookmark: BM1277266]9. 	To save the campaign information and begin the process of specifying other details such as the email settings, click Save and Continue. If you want specify the email settings later, click Finish.

[bookmark: BM1277267]When you click Save and Continue, the Marketing Email page displays on the screen:



For more information, see “Creating Email Marketing Records”.
[bookmark: BM1277271][bookmark: BM1277272]When you click on Finish, the campaigns detail page displays on the screen.  

[bookmark: _Running_Campaign_Diagnostics][bookmark: BM1277274][bookmark: _Toc314555043]Running Campaign Diagnostics
[bookmark: BM1277275]Executing an email campaign or a newsletter campaign involves several steps, some of which can be performed only by administrator. 

[bookmark: BM1277277]To run diagnostics
[bookmark: BM1277278]1. In the Action menu of the Campaigns module, click View Diagnostics.
[bookmark: BM1277282]The Campaign Diagnostics page displays on the screen:


[bookmark: BM1277283]If the email settings and a bounce-handling inbox have not been configured, warning messages display on this page. Contact the administrator to complete these tasks.
[bookmark: BM1277284]2. To perform the diagnostics again, click Re-Check.

[bookmark: BM1285362][bookmark: _Toc314555044]Testing Campaigns

[bookmark: BM1285384][bookmark: BM1285395][bookmark: BM1285415]Before lunch an email or newsletter campaign, it is recommended that you test it check how different email clients display the campaign message. To test a campaign click Send Test and on the Campaign’s detail page, select the message, and click Send. Ensure that you are sending out the campaign to the Test target list.

[bookmark: _Managing_Campaigns][bookmark: _Toc314555045][bookmark: BM1277287]Managing Campaigns 
[bookmark: BM1277288]
To manage campaign:.
· [bookmark: BM1277289]To sort the list view, on the Campaigns Home page, click any column title which has the  icon beside it; to reverse the sort order, click the column title again. 
· [bookmark: BM1277293]To update information for some or all campaigns, on the Campaigns home page, use the Mass Update panel.
· [bookmark: BM1277297]To view the campaign’s details, click the campaign name on the list. From the detail page, you can create Tracker URLs and Email Marketing Records for email campaigns. For more information on email campaigns, see “Executing an Email Campaign”.
· [bookmark: BM1277301]To edit the campaign information, on the detail page, click Edit.
· [bookmark: BM1277302]To duplicate the campaign information, on the detail page, click Duplicate.
· [bookmark: BM1441239]After you launch non-email campaign such as a Telesales or a Mail campaign, you will need to manually mark the campaign as “sent”. To do this, click Mark as Sent on the campaign’s detail page. When you click this button, the Campaigns sub-panel on a targets' detail page indicates the Activity Type as “Message Sent” to indicate that the campaign material was sent to that individual.
· [bookmark: BM1277304]To delete a campaign, on the detail page, click the Delete.
· [bookmark: BM1277306]To send an email campaign to the test group before the formal launch, click Send Test.
· [bookmark: BM1441281]To queue email campaigns for the launch, click Send Emails.
· [bookmark: BM1277307]To send out the campaign message to the target audience, click Send, and on the Campaign Send page, select the message and click Send.
· [bookmark: BM1277311]To view the campaign status, see “Viewing Campaign Status”. 
· [bookmark: BM1277312]To track changes to a campaign over time, in the detail view, click the View Change Log link.
· [bookmark: BM1277313]To export information on one or more campaigns, select them in the Campaign List sub-panel on the Campaigns Home page, click the Export icon, and export them as described in “Exporting Data”.
· [bookmark: BM1277319]To view or manage related records in a sub-panel, see “To manage related information in sub-panels”.
[bookmark: BM1277323]
[bookmark: _Viewing_Campaign_Status][bookmark: _Toc314555046]Viewing Campaign Status
[bookmark: BM1277324]After execute a campaign, you can view the campaign status to determine its success. From a campaign’s detail page, you can view the status and the result of the campaign such as the number of generated leads and the return on investment (ROI). 



[bookmark: BM1277329] The sub-panels on the View display the following information:
· [bookmark: BM1277330]A chart depicting the responses from campaign targets. This includes how many targets viewed the message, how many opened any links that were included in the campaign email, and how many opted out of the campaign.
· [bookmark: BM1277331]A list of any campaign emails are still in the queue to be sent out.
· [bookmark: BM1277332]A list of processed campaign emails.
· [bookmark: BM1277333]A list of targets who viewed the campaign email.
· [bookmark: BM1277334]A list of targets who viewed any links that were included in the campaign email.
· [bookmark: BM1277335]A list of leads that were created as a result of the campaign. These leads are created when targets identify the campaign and, as a result, are converted into leads.
· [bookmark: BM1277336]A list of contacts that were created as a result of the campaign. These contacts are created when leads identify the campaign and, as a result, are converted into contacts.
· [bookmark: BM1277337]A list of campaign emails that bounced back because of invalid email addresses. Note that this information is tracked only if your administrator has scheduled a job to track bounced emails.
· [bookmark: BM1277338]A list of campaign emails that bounced back for other reasons.
· [bookmark: BM1277339]A list of targets that opted out of the campaign.
· [bookmark: BM1277340]A list of opportunities that were generated from the campaign.

[bookmark: BM1277341]
To view campaign status

[bookmark: BM1277342]1. To view a campaign’s statistics, click the View Status link located below the Print icon on the Campaign detail page.

[bookmark: BM1556458]The system displays the campaign’s status:
[bookmark: BM1277356]
[bookmark: _Viewing_a_Campaign_s][bookmark: _Toc314555047]Viewing a Campaign’s Return on Investment 
[bookmark: BM1277357]TamTamCRM provides an embedded ROI report based on the “Closed/Won” opportunities generated from the campaign. View this report from the campaign’s detail page.

[bookmark: BM1277358]To view a campaign ROI report
[bookmark: BM1277359]1. On the campaign’s detail page, click the View ROI to view ROI report.
[bookmark: BM1556486]The ROI chart displays on the screen:



[bookmark: BM1277368]This bar chart displays the revenue versus the expected revenue generated from the campaign, as well as the actual cost of running the campaign versus the budget allocated for the campaign.

[bookmark: _Creating_Web_to_Lead_Forms][bookmark: BM1277371][bookmark: _Toc314555048]Creating Web-to-Lead Forms
Use this function to create a Web-to-Lead form. Use this lead information to generate more opportunities for your organization.
You can view and edit generated forms in the FCKEditor. To add new fields to the form, the administrator must first create new fields for the Leads module in Studio so that users can select them when they create the form.

[bookmark: BM1277375]To create a lead form
[bookmark: BM1277376]1. In the Action bar of the Campaigns module, click Create Lead Form.


[bookmark: BM1277381][bookmark: BM1277382]2. Click and drag the desired fields from the Available Fields list to the First Column or the Second Column list. To move all the fields, click Add All Fields.
[bookmark: BM1277383]3. Click Next.
[bookmark: BM1556514]The Form Properties page displays on the page:

 
[bookmark: BM1285150]4. Enter information for the following fields:
· [bookmark: BM1277389]Form header. The default header will be displays. You can delete and enter the desired header information.
· [bookmark: BM1277390]Form description. Enter a brief description of the form.
· [bookmark: BM1277391][bookmark: BM1277392]Submit button label. The default label displays on the page. 
· [bookmark: BM1277395]Post URL. The default location where the lead information will be stored displays on the page. Redirect URL. Enter the redirect URL. For more information, see “Creating Tracker Redirect URLs”.
· [bookmark: BM1277397][bookmark: BM1285179]Related campaign. Enter the name of the campaign. 
· Assigned to. Enter the name of the user who is assigned to this form. To select from the Users list, click Select. 
· [bookmark: BM1277398]Form footer. Enter the form footer (if applicable).
[bookmark: BM1277399]5. 	Click Generate Form to create a form.

[bookmark: BM1277403]The system generates the form and displays it on the FCK editor:


[bookmark: BM1277404]
You can edit the form in this editor, if needed.
[bookmark: BM1277405][bookmark: BM1277406]6. To save the form, click Save Web to Lead Form. The system saves it on your TamTamCRM server in the cache/generated_forms folder. 
[bookmark: _Cases_Module][bookmark: BM1277410]
[bookmark: _Projects_Module][bookmark: _Toc314555049]Projects Module
Use the Project Module to create, manage, and duplicate projects and project task.
To create a project;
1. In the Action bar, click Create Project.
2. On the project page, enter the following fields:
a. Name. Enter a name for the project. 
b. Status. Select the project status
c. Start Date. Click the calendar icon and select the project start date
d. End Date. Click the calendar icon and select the project end date.
e. Assigned To. Enter the name of the user who has ownership of the project. By default, it is assigned to you. 
f. Priority. Select the importance of the project. 
g. Description. Enter a brief description of the project.
3.  Click Save to create a project, Click Cancel to exit the page without creating the project.
4. Look at the example of filled in “Create Project” from below


To create a project task;
1. In the Project Task Sub-panel, click Create.
2. On the project task page, enter the following fields:
a. Name. Enter a name for the project. 
b. Task ID. Enter a numerical value as the task identification number 
c. Start Date. Click the calendar icon and select the task start date
d. Finish Date. Click the calendar icon and select the task finish date.
e. Assigned To. Select user to assign these task.
f. Status. Select the status from the dropdown list
g. Task Number. Enter the task number 
h. Order. Enter the order number for this task			
i. Estimated Effort (hrs). Enter the expected or estimated effort for this task.
j. Utilization. Select the utilization from the dropdown list
k. Percentage Complete. Enter the percentage of the task which has been completed.
l. Milestone. Check this book if the completion on this task is considered a milestone for project completion. 
m. Project Name. Choose the project associated with the task
n. Priority. Select the importance of the completing this task. 
o. Description. Enter a brief description of the project task.

3. Click Save to create a project task, Click Cancel to exit the page without creating the project task.
4. Look at the example of filled in “Create Project Task” from below


To manage a project


1. To update or delete some or all the projects on the Projects Home page, use the Mass Update panel on drop down action list.
2. To view the details of a project, click its name in the list view.
3. To edit the project details, click Edit on the project’s detail page, make the necessary changes, and click Save.

[bookmark: _Toc314555050]Importing and Exporting Data
In this chapter, we will discuss the problem of importing the data to TamTamCRM and exporting data from TamTamCRM .
[bookmark: _Importing_Data][bookmark: BM1062781][bookmark: _Toc314555051]Importing Data
[bookmark: BM1064440]
[bookmark: BM1073872]You can import data from Excel files, systems, and Contact Managers into TamTamCRM. When you import data, you will need to map fields that you are importing with fields that exist in the TamTamCRM database. For example, to map the first and last names of contacts that you import into TamTamCRM, these fields must exist in the TamTamCRM database. If not, you will need to create these custom fields in TamTamCRM before you import the data. You can import the following:
· [bookmark: BM1064625]Organizations: ACT! 2005, custom comma delimited files, and custom tab delimited files.
· [bookmark: BM1064626]Contacts: Microsoft Outlook, ACT! 2005, custom comma delimited files, and custom tab delimited files.
· [bookmark: BM1064058]Leads: comma delimited files, custom delimited files, and custom tab delimited files.
· [bookmark: BM1064059]Opportunities: comma delimited files, tab delimited files, and custom delimited files.
· [bookmark: BM1064633]Targets: Custom comma delimited files, tab delimited files, and custom tab delimited files. 
· [bookmark: BM1064631]Notes: comma delimited files, tab delimited files, and custom tab delimited files.

[bookmark: BM1066293]To import data from your previous application or Contact Manager, you must first export the data from that application in a Comma Separated Values (.csv) file format to your local file system. You can then use the import function within a specific module to import the CSV file data into TamTamCRM.

Organizations and Contacts

[bookmark: BM1066296][bookmark: BM1064652]If you import a contact record that refers to an unidentified organization, then a new contact record is automatically created. Note that when organization records are created automatically in this fashion, they are empty. Which means they have associated contacts but no address or telephone information. Therefore, you will need to manually add that info later. So, it is recommended that you import the organization data first to create complete records. If you are importing organization data from another system, then, typically, that system understands the distinction between a contact and an organization – that one organization can have multiple contacts – and has separate data for each. 

[bookmark: BM1064180]Leads and Opportunities 
[bookmark: BM1064169]Typically, only full system, such as Salesforce.com track leads and opportunities.
 
[bookmark: BM1064662]Targets
[bookmark: BM1064663]Targets, used in marketing campaigns, are stand-alone records that are not attached to contacts or leads. However, you can include contact, lead, and user records in a target list.

[bookmark: BM1064202]Notes
[bookmark: BM1064173]You can import notes related to a specific call, meeting, or task for distribution to participants. 

[bookmark: BM1064429]To export contacts from your current contact manager
[bookmark: BM1063629]The process below describes exporting contact information through Outlook 2003. Other systems tend to work in similar ways:

[bookmark: BM1063630]1. Under the File menu, select Import and Export. 
[bookmark: BM1063631]The Import and Export Wizard dialog box displays on the page. 
[bookmark: BM1063633]2. Choose Export to a file and click Next.
[bookmark: BM1063634]3. Choose the option to create a file of the type Comma Separated Values (Windows), and click Next.

[bookmark: BM1063635]4. Choose an Outlook folder from which to export – typically your contacts folder - and click Next.
[bookmark: BM1063636]5. Insert the filename and directory location for the exported file to be created, and click Next.

[bookmark: BM1063637]6. To confirm your intention to export this file, click Finish. 
[bookmark: BM1063638]Outlook 2003 creates a CSV file. To make sure that the data has been exported successfully, you can view the file using Microsoft Excel or a text editor.

[bookmark: BM1063752]During import, make sure that you correctly map the names of the incoming fields with the names of the corresponding TamTamCRM fields. If you are importing from Outlook, a particularly important field mapping is the incoming Company field to the Organization Name field within TamTamCRM. This is necessary to ensure that contacts are associated with the correct organizations. 


[bookmark: BM1063227]To import data
[bookmark: BM1063136]1. In the Action bar of the module’s home page, click Import:


[bookmark: BM1063140][bookmark: BM1063142]2. The first step in the import process displays on the screen. Select one of the following as the data source:
[bookmark: BM1063144]Microsoft Outlook. This option is available only for TamTamCRM modules that are mapped to a corresponding module in Outlook. Select this option if the data file is located in Microsoft Outlook.
[bookmark: BM1066681]Act!2005. This option is available only for TamTamCRM modules that are mapped to a corresponding module in ACT. Select this option if the data file is located in the Act! 2005 database.
[bookmark: BM1066216]Comma Delimited File. Select this option if the data file is in .csv format. 
[bookmark: BM1064236]Tab Delimited File. Select this option if the data file is in a tab delimited format.
[bookmark: BM1066698][bookmark: BM1063146]Custom Delimited File. Select this option if the data file is in TSV format.
Click Next to proceed to the next step in the import process:


  	
[bookmark: BM1063188][bookmark: BM1063172][bookmark: BM1063149][bookmark: BM1063150][bookmark: BM1063151]3. You must now upload the file that you saved on your local file system. In the Select file field, enter the path to the file location; or click Browse to navigate to the file location on your machine. If the file has a header row, check the Has Header box. Typically, a header row contains column titles such as Name and Address. Click on Next to proceed to the final step in the import process:


[bookmark: BM1064245]
[bookmark: BM1063152][bookmark: BM1063153]4. You must now map the fields from the export file to the fields in the TamTamCRM database to successfully import the data. From the Database Field drop-down list, select the appropriate field in the note, such as Full Name and map it to the row in the imported source file. If you want to ignore a field, select Do not map this field. To save the mapping as a custom mapping that you can use repeatedly, select the Save as Custom Mapping checkbox. 
[bookmark: BM1063154][bookmark: BM1066623][bookmark: BM1066614]To check indexes for duplicate values for fields such as Deleted, and Assigned users, move the desired indexes from the Index(es) Not Used column to the Index(es) Used column using the left arrow button. To remove an index that you do not want to check, use the right arrow to move it back to the Index (es) Not Used column. Use the up and down arrows to sort the order in which the indexes are checked for duplicates. Click Import Now to import the data:

[bookmark: BM1085043]
The Import Results page lists the imported data and lists how many fields were successfully imported and how many were skipped.
 
[bookmark: BM1075273]5. To import additional data, click Import More.
[bookmark: BM1063157]6. To end the task, click Finished.
7. 
[bookmark: BM1063158]If you do not want to save the imported data, click Undo Last Import; You can click Try Again to restart the import process.
[bookmark: BM1063892]
To import organization data
[bookmark: BM1063893]If you are importing organization data from a system, proceed to step 4. If you export contact data, and need to massage it to act as organization data to be imported, perform steps 1-4 below:
[bookmark: BM1063894]1. Copy your exported contacts.csv file and save it as Organizations.csv.
[bookmark: BM1063895]2. Edit the Organizations.csv file using Excel. First, sort the file on the column which contains the company name. 
To avoid multiple copies of the same organization within TamTamCRM, you need to delete the duplicate contacts. And to make sure that the most complete information is attached to the organization record, retain only the contact whose address and telephone information best represents the organization as a whole. 
[bookmark: BM1063897]Also look out for company names which are similar but not identical due to inconsistencies in the way the company name was entered – you should delete all duplicate records except the one with the company name spelt exactly how you want to see it in TamTamCRM.
[bookmark: BM1063898]3. Save the Excel file as a .csv file type.
[bookmark: BM1063899]4. In the Actions bar of the Organizations module, click Import and follow the process described in “Importing Data”.
[bookmark: BM1063903]Now that organization data has been imported, you can export contacts from your current Contact Manager and then import it into TamTamCRM.

[bookmark: _Exporting_Data][bookmark: BM1063832][bookmark: _Toc314555052]Exporting Data
[bookmark: BM1063833]You can export item records in .csv format to your hard drive. You may use Microsoft Excel, Notepad, or other text editors to open .csv files. You can export selected records, all records on the page, or the entire list.
[bookmark: BM1063835]A sample portion of a CSV file, exported from the Organizations module and viewed in Excel, is shown in below. 

[bookmark: BM1062472] 
To export data from TamTamCRM

1. Select or tick the records from the List View on the module’s home page.
2. Select Export from the Actions drop-down menu in the List View.
3. To export all records, click Select located above the item list and select one of the following options:
· This Page. This function is to export all the records listed on the page.
· All Records. This function is to export all records on the list.
4. The system will display an “Opening.csv” dialog box .
5. Click Open to open the export file in .csv format or click Save to Disk to save the .csv file to your hard drive.
6. Click OK to execute the operation. If you chose to open the file, the csv file opens in Microsoft Excel. 
[bookmark: _Quick_Administration_Hints]


[bookmark: _Toc314555053]Reference 
[bookmark: _Toc314554873]https://www.sugarcrm.com/network/help/OS/6.1/Application_Guides/Sugar_Community_Edition_Application_Guide_6.1.0/Sugar_CommunityEdition_Application_Guide_6.1.0.pdf
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